
Chapter 8: Operator Display Windows 
This chapter examines the configuration and use of the display windows available in WinFrog. 

 I/O Devices  
 Graphics  
 Profile 
 Vehicle Text  
 Acoustics 
 Anchor Handling 
 Anchor Information 
 Alarms 
 Attitude  
 Auditor 
 Bird’s Eye  
 Calculations  
 Controlled Remote 
 Distance Counter 
 Dynamic Tracking 
 GPS QA/QC 
 Helmsman  
 Level Bubble 
 Numerics 
 Smart Remote Control 
 Time Synchronization 
 Tracking Offsets 
 Cable Model Large Window 
 Cable Model Small Window 

 
Any of these windows can be displayed in the WinFrog work area by simply choosing them 
from the View menu. 

Note: some options, such as the Graphics, I/O Devices, Calculations, and Vehicle Text 
windows allow for multiple displays of the same type. Each additional window opened is 
labeled with a number to differentiate it from the original. 

The main menu item Window lists all of the currently enabled windows with a checkmark next 
to the “active” window. When you click anywhere within the bounds of a window to make it 
active, it displays in front of all other windows. You can also choose the window’s name from 
the list under Window in order to make it active. Any of the windows that are user-configurable 
must be made active before they can be modified. 

Note: because of its importance, the Vehicle Text window can be configured to always be on 
top of other displays. See the Vehicle Text window section below for more details. 

On non-initial launches of WinFrog, the windows previously used are displayed in the same 
layout because window configurations are saved in the WinFrogini.wfg file each time you exit 
WinFrog. 
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Maximizing Available Monitor Space 
Since a large number of windows can be displayed simultaneously, all available monitor display 
space is quickly used. Even with the most basic WinFrog configurations, the monitor becomes 
filled, requiring you to limit your selections. Preferred selections typically include the I/O 
Devices, Vehicle Text, and Graphics windows. A split-screen graphics card and second 
monitor should be added if you intend to display any of the other available views on a regular 
basis. 

To Maximize Available Monitor Space 
WinFrog has four functions to help maximize the use of the available screen space:  

1 As mentioned above, the main menu item Window lists all of the currently enabled 
windows, with a checkmark located beside the active window. Making a window active 
will display it in front of any other window. Using this feature, you can overlap windows 
and quickly bring the required window to view as desired. 

2 The main menu item Configure > Virtual Screen provides you the ability to configure 
additional “virtual screens.” Each can be individually configured for content and layout. 
(More on this feature in the section named Virtual Screen Configuration below.) 

3 Also under the Window option is the Cascade feature. This function re-organizes all of the 
windows so that they are only partially overlapping. This allows for easy selection of all 
windows. 

4 In the top right corner of each window are the three standard WindowsTM functions: 
Minimize, Maximize, and Close. Select the Minimize button to shrink the window to 
display only the Title bar. You will be able to see this in the lower left corner of the 
WinFrog display. (Note: a minimized window may be hidden under the Vehicle Text 
window). 

Virtual Screen Configuration 
As mentioned above, WinFrog’s numerous displays are quickly able to cover all available 
monitor display space. To assist in efficient use of limited space, WinFrog allows you to 
configure up to 24 “virtual screens” and then choose which display will be viewed. The 
following sections detail the configuration and selection of virtual screens. 

To Configure Virtual Screens 
WinFrog’s Virtual Screens are configured by selecting the main menu item Configure > 
Virtual Screen. The Configure Virtual Screen dialog box displays, as seen below. 
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Virtual Screen Resolution 
Horizontal/Vertical Displays the monitor’s current horizontal and 

vertical resolution settings. This value is read 
from the computer’s display settings and cannot 
be altered here. 

Primary Display Resolution 
Horizontal/Vertical Enter the horizontal and vertical resolution 

settings desired for each virtual display. 
Typically, you would enter the same values as 
displayed above (Horizontal: 1024, Vertical: 
721) in the Virtual Screen Resolution entry 
windows. 

Display Array Size 
Horizontal Enter the number of virtual screen “columns” to 

be created. The new virtual screens are created 
to the right of Display Number 1 (see the next 
figure). For example, the drawing below depicts 
an entry of 4 in this window. 

Vertical Enter the number of virtual screen “rows” to be 
created. The new virtual screens are created 
below the row containing Display Number 1. 
For example, the drawing below depicts an entry 
of 2 in this window. 
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A shortcut button, with the number “1” on it, resides on the WinFrog toolbar for the default 
virtual screen. When you configure additional screens and exit this dialog, shortcut buttons are 
placed on the toolbar with numbers representing each virtual screen. Click a shortcut button to 
make that virtual screen the active window. Once the desired display number is selected, you 
can add or move the various WinFrog display windows to this virtual screen as desired. 

I/O Devices Window 
WinFrog’s I/O Devices window displays real-time data for all peripheral devices configured in 
WinFrog. This window allows you to view incoming decoded data and outgoing data, edit 
device interface protocols, and edit operating parameters for each device. Optionally, you can 
add a terminal tab that displays the raw telegram in ASCII, HEX or binary format. For detailed 
information concerning configuring peripheral devices in WinFrog, refer to the Peripheral 
(I/O) Devices chapter.  

Multiple I/O Device windows can be displayed at the same time, enabling you to view data 
from different devices at the same time.  

NOTE: You cannot display the data from the same device in more than one window at a time. 

To Display the I/O Devices Window 
1 From the View menu, choose Devices. 

 

The I/O Devices window is divided into two sections: The left side of the window lists all 
devices that have been added to WinFrog, while the right side of the window displays Decoded 
Data and the Terminal tab if enabled.  
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To view the Decoded Data or Terminal data for a specific device, simply click on that 
particular device name in the left side of the I/O Devices window. The Decoded Data or 
Terminal portion of the I/O Devices window updates approximately once every half second, 
displaying data for the chosen device. 

The I/O Devices window also provides functions that allow you to edit, configure, add, and 
delete devices. 

With the mouse pointer in the left side of the I/O Devices window, right-click to access the 
following options: 

Edit I/O Select this option to configure the input/output 
(I/O) parameters for the currently selected 
device. 

Configure Device Select this option to configure “generic” 
parameters for the currently selected device, if 
available. 

Timeout Warning Use this to enable an alarm when data is no 
longer received from the device. Click the 
No/Yes to toggle; click the time to open an edit 
box to change the timeout time. 

Add Device Select this option to open the Add Devices 
dialog box. 

Delete Device Select this option to delete the currently selected 
device. 

 
With the mouse pointer in the right side of the I/O Devices window, right-click to access the 
Change Font feature or to enable/disable the Terminal tab feature (see graphic above). Select 
Change Font to open a standard WindowsTM Font configuration dialog box. Select the desired 
options then click OK to return to the I/O Devices window. Note: only the Decoded Data 
portion of the I/O Devices window uses the selected Font options. 

Graphics Window 
The Graphics window is the main navigational display generated by WinFrog. The Graphics 
window can be configured to display all vehicles, survey lines, waypoints, picture file data, 
manual events, cable events, data logged using automatic events, transponder locations, and 
charts. In addition, the Graphics window can display latitude and longitude grid lines, Northing 
and Easting grid lines, a grid with an origin at the center of the Graphics window, a North 
arrow, scale, and chart information. 

A feature that is useful for multi-vehicle applications is the ability to display more than one 
Graphics window. Each Graphics window can be independently configured to display 
different information. 

To Display a Graphics Window 
1 From the View menu, choose Graphics. WinFrog’s default configuration will open the 

Graphics window in the top right corner of the WinFrog workspace. 
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To Configure the Graphics Window 
1 If more than one Graphics window is currently displayed, you must specify which one will 

be “active.” To do so, either click the title bar of the one to be configured or select the main 
menu bar item Window and select the appropriate Graphics window. 

2 From the Configure menu, choose Graphics, or alternatively, move the mouse pointer into 
the Graphics window, right-click and select Configure Graphics. 

The following parameters are configured using the Configure Graphics dialog box: 
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Center Tab 

 

Center on Position  
(Geo/Grid) Select this option to center the Graphics 

window at the coordinates displayed in the box, 
regardless of the current vehicle position. The 
coordinates can be either entered in geographic 
latitude and longitude (if the Geo radio button is 
selected) or in grid Northing and Easting (if the 
Grid radio button is selected). 

 
You can also manually position the center of the Graphics window by using the Mouse Pan 
function. To use this function you must first have the Center on Position mode selected above. 
Then, select the Mouse Pan icon from the toolbar. Left-click and hold then move the hand icon 
to the desired location. This will re-center the Graphics screen to the specified point. You can 
also pan the Graphics window regardless of which toolbar button is selected by clicking and 
holding the center mouse button. Note: if the Center on Vehicle mode is selected for the 
Graphics window you can still pan by either of these methods, but after releasing the mouse 
button the Graphics window will spring back to center on vehicle. If other modes are selected 
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(e.g. Center on Waypoint) the centering mode will switch to Center on Position. 

Center on Vehicle Select this option to have WinFrog 
automatically re-center the Graphics screen in 
reference to the vehicle’s current point of 
reference. If you decide to use either Mouse Pan 
functions while in this mode, when you release 
the mouse button it will revert back to Center on 
Vehicle. Note: the Graphics screen may be 
constantly refreshing itself if the vehicle is 
moving and the depicted scale is quite small. 
This may make viewing of the Graphics display 
difficult. 

Center on Waypoint Select this option to have WinFrog 
automatically re-center the Graphics screen in 
reference to the selected waypoint position. If 
you decide to use either Mouse Pan functions 
while in this mode, the software will 
automatically change to Center on Position on 
the point where you release the mouse button. 

Center on Map Select this option to center on the background 
map loaded from the Background tab. 

 
Recentering Features These options are associated with the Center on 

Vehicle setting and control how the Graphics 
window redraws relative to the selected vehicle. 

Reposition vehicle  
when % from center This field allows you to enter a value as a 

percentage. This is the percentage of the 
distance between the center and the display edge 
in which the current vehicle is permitted to 
travel before the Graphics window is refreshed. 
When the current vehicle reaches the re-center 
percentage limits of the Graphics window edge 
(in any direction), the Graphics window 
redraws as configured. Note: Use this ability 
sparingly as too small of a percentage will cause 
WinFrog to refresh the screen too often, 
dramatically slowing system performance. 

  
The next figure shows the permitted screen area available to the current vehicle in which to 
travel before a pan is performed to move the vehicle back to the center of the window. 
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Reposition vehicle at  
Window center Select this option if you want the window to 

redraw with the selected vehicle at the center of 
the window. 

Reposition vehicle  
near edge Select this option if you want the window to 

redraw with the selected vehicle near the edge of 
the screen. WinFrog calculates a new window 
center based on the selected vehicle’s CMG and a 
percentage of the distance from the window center 
to the redraw boundaries relative to the vehicle’s 
CMG. This allows you to configure the window to 
minimize the redraw frequency when centering on 
a moving vehicle; or configure the redraw to keep 
both a towed vehicle and its reference vehicle in 
the window. A positive percentage places the 
selected vehicle astern of the window center, i.e. 
sailing towards the window center on a redraw. A 
negative percentage places the selected vehicle 
ahead of the window center, i.e. sailing away from 
the center. 
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Scale Tab 

 

1: field The value entered here configures the scale at 
which data are displayed in the Graphics 
window. One unit on the Graphics screen 
equals X (user-entered) units in the real world. 

Zoom Factor field The value entered here configures the factor by 
which the scale of the display is increased when 
the display is zoomed out or decreased when 
zoomed in. 

You can rapidly change the scale of the Graphics screen by selecting the Zoom In or 
Zoom Out buttons from the button menu bar. 

Plot Scale checkbox Enable this to display the current Scale on the 
Graphics screen. 
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Rotation Tab 

 

Rotate To Angle field This option allows you to manually specify the 
Graphics display Rotation Angle. You must first 
select Manual from the dropdown box options, 
then highlight and enter the desired rotation 
Angle, as measured clockwise from North. 

dropdown Select from the dropdown options to have 
WinFrog align the Graphics window in 
accordance with one of the following provided 
options: 

Grid North The grid displays with zero rotation applied i.e. 
the North arrow will be straight “up” in the 
display. 

Survey Line The Graphics display is aligned with the 
Currently Tracked Segment of the selected 
Survey Line 

 The orientation of the Graphics window will 
change as required so that the survey line is 
aligned from the bottom of the window to the 
top of the window. When the survey line is 
tracked in the forward direction, the Start of 
Line is at the bottom of the window. When the 
survey line is tracked in the reverse direction, 
the End of Line is at the bottom of the window. 
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Reverse Survey Line  Rotates the Graphics display 180 degrees from 
the current survey line segment direction, as 
detailed above. 

Manual Rotates the Graphics display to an angle of your 
preference. The value entered refers to degrees 
as measured clockwise from North. 

Centered Vehicle Hdg  Rotates the Graphics display to keep the bow of 
the centered vehicle pointed up. The rotation 
will automatically update when the heading of 
the vehicle the Graphics window is centered on 
changes by an amount equal to or greater than 
the amount specified in the ‘Rotation Update 
Delta’ field. The rotation will only update if the 
graphics window is centered on a vehicle. When 
this option is selected the ‘center grid’ display 
will no longer rotate with the background 
display. 

Rotation Update Delta field This field is enabled when the Centered Vehicle 
Hdg rotation option is selected. This option allows 
you to set the amount the heading of the centered 
vehicle must change before the graphics rotation 
angle is updated.  

Vehicle dropdown If you have chosen Survey Line or Reverse 
Survey Line in the Rotate To dropdown, you 
may select the survey line associated with a 
specific vehicle. 

 
Note:  Rotation options are not available when displaying a raster chart with the Blue 
Marble GeoView Library. 
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Grids Tab 

 

Enable Projection Grid Select this option to enable the plotting of Northing 
and Easting grid values at regular intervals in the 
Graphics window. The grid values are also drawn 
as ticks and crosses to show the location of grid 
intersections. 

Enable Geographic Grid Select this option to enable the plotting of 
geographic (latitude and longitude) coordinates 
labels and lines in the Graphics display. 

Enable Center Grid Select this option to enable the plotting of a 
“cross” centered in the middle of the Graphics 
display. The cross is also annotated at regular 
intervals showing the distances from the center to 
the North, South, East, and West limits. 
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Background Tab 

 

Plot Picture Select this option to enable the display of the 
contents of the Working Picture File. (See the 
Working Picture File section in the Working 
Files chapter for more details.) 

Plot Charts Select this option to enable the display of a 
raster chart. See the Charts section later in this 
chapter for more detail on chart configuration. 

Chart Options button Explained in the Charts section later in this 
chapter. 

Plot Map Select this option to enable the display of Blue 
Marble map (BMM) files. See the Blue Marble 
Map File Support section later in this chapter 
for more information. 

User Draw Select this option to enable the display of a Blue 
Marble Layer (BML) file on which to draw 
graphic objects. The options available are to 
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open an existing BML file or create a new BML 
file. See the User Drawing Support section 
later in this chapter for more information. 

Use Alternate Colors Select this option to configure WinFrog to use 
different colors for the Background and 
Gridlines and Text in the Graphics window. 
Use the Edit buttons to change the colors as 
desired. Note that if a background map is 
displayed using the Blue Marble library, no 
adjustment is made to avoid masking of features 
by the chosen background color, if the feature 
and the background are the same color. 

Display MBES  
Coverage Map This option is dependent upon the MBES Data 

Logging module. Select this option to configure 
WinFrog to display the current multibeam 
coverage map as the background. For details, see 
EM4 - Multibeam Logging and Display. 

Draw Coverage Map  
Work Area bounds This option is dependent upon the MBES Data 

Logging module. Select this option to configure 
WinFrog to display the polygon that defines the 
coverage map work area boundary. For details, 
see EM4 - Multibeam Logging and Display. 
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Lines/Waypoints Tab 

 

Plot Survey Lines Select this option to display the contents of the 
Working (.PTS) Survey Line file. Note: if a 
vehicle is tracking a survey line, the line color 
will temporarily change from its original color 
(as defined in the Working Survey Line File) 
to the color of the vehicle. 

Survey Line Width Use the drop down menu to change the width of 
the survey line as seen in the Graphics and 
Bird’s Eye displays. 

Plot KP Markers Select this option to enable display of KP Markers 
(as calculated on the currently tracked survey line) 
in the Graphics and Bird’s Eye displays. Use the 
drop down menu to change between 0.5 km or 1 
km intervals. 

Plot Waypoints Select this option to display the contents of the 
Working (.WPT) Waypoint file. Each 
individual waypoint can be displayed with a 
different color and icon, as defined in the Edit 
Working Files... Waypoints > Waypoint 
dialog box. See the Working Waypoints 
section of the Working Files chapter. 

 This customization helps you easily identify 
different types of waypoints, i.e. navigation 
hazards, cable events, and alter courses (A/Cs) 
can each be depicted differently. Similar to 
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survey lines, a waypoint will change to the 
vehicle color after it is selected for tracking. 

Fix Data Tab 

 

Plot Data Files (*.ALG) Select this option to enable the plotting of the 
automatic (.DAT) events contained in the 
Working (.ALG) Data file. Each event is 
plotted as an X centered at the event location. If 
the scale is greater than 1:7000, the X is 
annotated with the event number. 

Edit The color used to display the events can be 
selected. The current selection is displayed. To 
change the selection, click the Edit button. 

Select Vehicle The event data is collected for all vehicles that 
are configured for either Event Primary or Event 
Secondary. To limit the display of event data to 
a specific vehicle, click the Select Vehicle 
button. In the dialog, select either ALL to 
display event data for all vehicles for which data 
has been logged, or a specific vehicle. Only 
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those vehicles that are configured for Event 
Primary or Event Secondary appear in the list. 

 

Note: you can remove .DAT files from the Working .ALG file to limit the amount of data 
displayed on the Graphics screen. Likewise, you can add .DAT files back to the Working 
Data .ALG file to increase the amount of data shown. 

Plot Seismic Receivers File 
(*.ALL) Select this option to enable the plotting of the 

automatic Receiver (.RCV) events contained in 
the Working Seismic Receivers (.ALL) file. 
Each event is plotted as an X centered at the 
event location. If the scale is greater than 
1:7000, the X is annotated with the event 
number. These events are plotted in green and 
only for the Event Primary vehicle. 

Note: you can remove Receiver (.RCV) files from the Working Seismic Receiver (.ALL) file 
to limit the amount of data displayed on the Graphics screen. Likewise, you can add Receiver 
(.RCV) files back to the Working Seismic Receiver (.ALL) file to increase the amount of data 
shown. 

Plot Seismic Source File 
(*.ASC) Check this option to enable the plotting of the 

automatic Seismic (.SRC) events contained in 
the Working Seismic Source (.ASC) file. Each 
event is plotted as an X centered at the event 
location. If the scale is greater than 1:7000, the 
X is annotated with the event number. These 
events are plotted in blue and only for the Event 
Primary vehicle. 

Note: you can remove Seismic (.SRC) files from the Working Seismic Source (.ASC) file to 
limit the amount of data displayed on the Graphics screen. Likewise, you can add Source (.SRC) 
files back to the Working Seismic Source (.ASC) file to increase the amount of data shown. 

Plot Log Files (*.LOG) Select this option to enable the plotting of all 
Manual Events in the Working Logs (.LOG) 
File. Each event is plotted as a square centered 
at the event location. If the scale is greater than 
1:40000, the square is annotated with the event 
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number. The event is plotted in the color of the 
respective vehicle. 

Select Vehicle The event data is collected for all vehicles. To 
limit the display of event data to a specific 
vehicle, click the Select Vehicle button. In the 
dialog, select either ALL to display the manual 
event data for all vehicles, or a specific vehicle. 

Plot Manual Cable Events 
(*.CET) Select this option to enable the plotting of all 

Manual Events in the Working (.CET) Cable 
Events file. If the scale is greater than 100000, 
the event is plotted with the respective icon, 
otherwise it is plotted as an X. If the scale is 
greater than 1:7000, the icon is annotated with 
the comment. 

Select Vehicle The event data collected depends on whether or 
not the Cable Model is active or not. In the case 
of the Cable Model not being active, the event 
data is collected for all vehicles. In the case of 
the Cable Model being active, the event data is 
logged for the tow and plow vehicles, depending 
on the configuration. To limit the display of 
event data to a specific vehicle, click the Select 
Vehicle button. In the dialog, select either ALL 
to display the manual event data for all vehicles, 
or a specific vehicle. 

Plot Auto Cable Events Plots all events automatically recorded in the 
currently open Cable Database (.MDB) file. If 
the scale is greater than 100000, the event is 
plotted with the respective icon, otherwise it is 
plotted as an X. If the scale is greater than 
1:7000, the icon is annotated with the comment. 
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Misc Tab 

 

Plot North Arrow Select this option to plot a North Arrow in the 
top left-hand corner of the Graphics window. 

Label Measurement Cursor Select this option to label all measurement 
cursor lines with the associated range and 
bearing information. The information is 
displayed below the respective line upon 
completion of the measurement. The 
information is displayed in geographic or map 
projection grid terms depending upon the 
Units\Coordinates configuration setting. The 
range is displayed in the units selected for 
Units\General-Distances. The bearing is always 
based on the direction from the start point (large 
cross) to the end point (small cross) and is 
displayed as “ddd.dd°”. 

Plot Xponder Files Select this option to plot all fixed LBL and 
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USBL transponders in the Working 
Transponders (.XPT) file as green, unfilled, 
name-labeled circles. A label is plotted only if 
the scale is less than 1:7000. 

Plot Control Stations Select this option to plot all Control Stations in 
the Working Control Stations (.CLS) file. 

Plot As-Laid Cable Select this option to plot the cable location as 
determined from the Working Cable Database 
(.MDB) file. 

Radar Target Display Setup  
If the Rho-Theta device RADAR Targets or NMEA RADAR is present and 
outputting radar targets they will be plotted on the Graphics window. This group 
box allows control of the plot. Select the color and shape in which to display all 
the targets. 
Plot Acoustic Calibration 
Data  Select this option to enable the plotting of the 

results, baselines observed and error ellipses of 
an LBL or USBL transponder position 
calibration directly from the calibration file 
currently in memory. Select which data to plot 
from the provided Acoustic Calibration Display 
Setup options (See Acoustic Display Setup 
description below).  

 Note: A calibration file must be in WinFrog 
memory in order for it to be displayed. 

Acoustic Calibration Display Setup 
This section is enabled if the Plot Acoustic Calibration Data checkbox is 
selected. The calibration data to be displayed is taken from the acoustic 
calibration file currently in memory, whether loaded from file or available 
directly after logging and processing. Select the features to be displayed using the 
appropriate dropdown list and checkboxes. 

Select Calibration 
Vehicle The calibration data is associated with a vehicle. 

Select the respective vehicle from this dropdown 
list box.  

 Note: Only those vehicles that have either an 
LBL TRANSCEIVER or USBL 
HYDROPHONE data item associated with them 
are listed since these are the only vehicles with 
which an acoustic calibration file can be 
associated. 

Plot Station Ellipses The absolute error ellipses associated directly 
with a given station can be plotted by selecting 
this checkbox.  

Plot Relative Ellipses The relative error ellipses associated with a 
given station pair can be plotted by selecting this 
checkbox.  

Plot Baselines The baselines observed for the calibration are 
displayed by selecting this checkbox.  
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 Note: All baselines that were observed are displayed 
regardless of their current weighting or validity. 

Error Ellipse Type Geometric or estimated error ellipses can be 
displayed based on the radio button setting. For 
more information on these types of ellipse, 
please refer to the USBL & LBL Calibrations 
chapter, specifically the Viewing the LBL 
Solution Statistics section. 

Ellipse Scale The ellipse scale field allows you to enter the 
display scale to be used for displaying the error 
ellipse. This can be different from the map scale. 
This allows the error ellipses to be drawn large 
enough to be viewable in the Graphics window. 
The number in the field is multiplied by the 
current graphics scale factor to determine the 
scale at which the error ellipse is drawn. 

AIS Vessels 
This group allows you to display vessels whose positions are being received 
using an AIS device. You must setup the NMEA AIS device driver. Select to 
display none, all, or only those within the indicated distance from the vehicle 
to which the AIS data item is attached. These vehicles are all the same shape 
and size. When the mouse hovers over one (focus must be for the graphics 
window and the regular cursor selected) the name and MMSI will be 
displayed in the bottom tool bar. 
 
MS1000 Targets 
This group allows the display of targets received by WinFrog using the ROV 
device named MS1000. This data can be displayed both at the master 
WinFrog that has the device and on an unlicensed (Smart Remote) WinFrog. 
A small triangle with the target number (1 to 9) in the selected color will be 
displayed for the length of time indicated. Up to nine targets may be 
displayed. Any target will be erased when a new target with the same number 
is received. 
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Graphics Window Pop-up Menu 
A pop-up menu is available to provide quick links to several related features. Right-clicking in 
the Graphics window accesses the menu as seen below. 

Zoom In  Clicking this has the same effect as 
clicking the Zoom In button in the tool bar; it 
causes the Graphics window to zoom in by the 
factor set in the Configure Graphics dialog’s Scale 
tab. 
Zoom Out  Clicking this has the same effect as 
clicking the Zoom Out button in the tool bar; it 
causes the Graphics window to zoom out by the 
factor set in the Configure Graphics dialog’s Scale 
tab. 
Pan On   This item is enabled if the cursor type is 
currently not Pan. Selecting this changes the cursor 
to Pan. It has the same effect as clicking the Pan 
button in the tool bar. 
Pan Off  This item is enabled if the cursor type is 
currently Pan. Selecting this changes the cursor to 
Display Position. It has the same effect as clicking 
the Display Position button in the tool bar. 
Zoom Window On  This item is enabled if the 
cursor type is currently not Rectangle Zoom. 
Selecting this changes the cursor to Rectangle 
Zoom. It has the same effect as clicking the 
Rectangle Zoom button in the tool bar. 

Zoom Window Off This item is enabled if the cursor type is currently 
Rectangle Zoom. Selecting this changes the cursor 
to Display Position. It has the same effect as 
clicking the Display Position button in the tool bar. 

Mouse Zoom On This item is enabled if the cursor type is currently 
not Mouse Zoom. Selecting this changes the cursor 
to Mouse Zoom. It has the same effect as clicking 
the Mouse Zoom button in the tool bar. 

Mouse Zoom Off This item is enabled if the cursor type is currently 
Mouse Zoom. Selecting this changes the cursor to 
Display Position. It has the same effect as clicking 
the Display Position button in the tool bar. 

Configure Clicking this item opens the Configure Graphics 
dialog. 

Stop Drawing This item is enabled if the User Draw option is 
enabled (see Configure Graphics dialog, 
Background tab) and a drawing feature is active. 
Selecting has the same effect as clicking the Stop 
Draw button in the tool bar. 

Edit Drawing This item is enabled if the User Draw option is 
enabled and an object has been selected using the 
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Select Object button in the tool bar. Selecting this 
allows you to configure respective features of the 
selected object, e.g. color. 

Delete Drawing This item is enabled if the User Draw option is 
enabled and an object has been selected using the 
Select Object button in the tool bar. Selecting this 
allows you to delete the selected object. 

Map File Name This item is enabled if the Plot Map option is 
enabled. Selecting displays the file name of the 
map currently being displayed. 

Add Waypoint Selecting this item allows you to add a waypoint at 
the location of the last left mouse click in a 
Graphics window. If selected, the Waypoint dialog 
is displayed. 

Add Text Selecting this item allows you to add text at the 
location of the last left mouse click in a Graphics 
window. If selected, the Configure Text dialog is 
displayed. 

Cursor Features 
The cursor can be used to access information pertaining to acoustic calibration data, view and 
edit waypoints, obtain some vehicle information, and zoom in and out directly. 
 
Acoustic Calibration Data Access 
If the Graphics window is configured to display acoustic calibration data (see Plot Acoustic 
Calibration Data in the Misc Tab above) and the cursor is placed over a calibration station, the 
cursor changes to a target cursor ( ). Right-clicking while the target cursor is displayed results 
in a pop-up menu with the item Show Statistics. Clicking on this item results in a message box 
to be displayed giving the calibration information for the station, including statistics and error 
ellipse information. Alternatively, double-clicking while the cursor is a target cursor will result 
in the display of the same message box. 
 
Waypoint Information Access 
If the Graphics window is configured to display waypoints (see Plot Waypoints in the 
Lines/Waypoints Tab above) and the cursor is placed over a waypoint, the cursor changes to a 
target cursor ( ). Double-clicking (left) when the target cursor is displayed results in the 
Waypoint dialog being displayed allowing the viewing and editing of the waypoint data. 
Editing the waypoint settings and exiting the Waypoint dialog with OK will result in the 
immediate updating of the Working Waypoint file. 
 
Note: If a waypoint and a calibration station are co-located, the acoustic calibration data 

feature takes precedence. 
Note: The target cursor is only activated if the Graphics window has the focus. To set the 

focus, click in the window. 
 
Vehicle Information Access 
If the mouse arrow cursor (Display Position mode) is placed over the CRP of a vehicle the 
cursor changes to a target cursor ( ). Double-clicking (left) when the target cursor is displayed 
results in the display of some basic information on the vehicle – name, color, current reference 
offset, etc. 
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Zoom In and Out 
The Graphics window can be zoomed in or out by selecting the Mouse Zoom cursor from the 
tool bar ( ) or the pop-up menu, clicking and holding the left mouse button down and 
dragging the cursor in the Graphics window. Dragging the cursor up will result in the window 
zooming in, dragging the cursor down will result in the window zooming out. 
 
Note: The zoom action is dependent on the vertical cursor movement, not the horizontal. The 

ratio of the vertical movement to the horizontal must be greater than 1:1 for any zooming 
to occur. 

Charts 
WinFrog can be configured to display either raster or vector format charts in the Graphics and 
Bird’s Eye displays. 

See the instructions in the following section for information on displaying.RML, .HDR and 
.BSB format raster charts.  

WinFrog now uses the Blue Marble GeoView Library to display other types of vector and 
raster files. The supported vector file types are DXF, DWG, SHP, MIF, DGN, and BML. The 
supported raster file types are JPG, BMP, TIF and GEOTIFF. See the Blue Marble Map File 
Support section later in this chapter for information on displaying Blue Marble Map (BMM) 
files that contain the supported file types. 

Displaying a Raster Chart in WinFrog 
The following instructions apply to.RML, .HDR and .BSB format raster charts. It is 
recommended that the charts be installed onto a local hard drive.  

To Display a Raster Chart 
1 From the Configure menu, choose Graphics. 

2 On the Background tab of the Configure Graphics dialog box, select the Plot Charts 
checkbox. 

3a If this is the first time you are displaying a chart, the First Time Chart Selection dialog 
box will appear. Click the Browse for Chart button and locate the desired chart file. Click 
OK. 

3b If you have already displayed a chart and want to choose a different chart file, click the 
Chart Options button (on the Background tab of the Configure Graphics dialog box) to 
display the Chart Configuration dialog. 
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4 Click the Find Chart button. The Chart Finder dialog displays. 

 

5 The Chart Finder dialog box provides three options for selecting .BSB charts. 

Option 1: Click the Browse button to manually find the desired file.  

Option 2: Enter the Search Path in the provided entry window and select the Find All 
BSB Charts button. This will initiate an automatic search of the defined computer 
directories for the desired file. 

Option 3: Enter a Search Path and the required Latitude and Longitude values in the 
provided entry windows, then select the Find All BSB Charts By Position button. This 
initiates an automatic search for a .BSB file that covers the specified coordinates. 

6 Once the desired file is located, highlight the file name, and click Open. 

Note: some .BSB files can refer to more than one chart. If more than one file is associated with 
the selected .BSB file, the Select Chart dialog box appears. Select the desired chart (by name) 
and click the OK button. WinFrog will briefly display a Creating Chart dialog box then 
automatically return to the Chart Configuration dialog box. Click OK to close the Chart 
Configuration dialog box and return to the Configure Graphics dialog box. 
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See the next section for more information on viewing the selected chart. For more details on the 
other options found in the Chart Configuration dialog box, see the Raster Chart Options in 
the Chart Configuration Dialog Box section. 

Raster Chart Viewing Tips/Hints  
There are certain conditions that must be met before a raster chart can be seen in the Graphics 
display. 

1 Obviously, the correct chart must be selected. It is preferable that the selected chart be 
located on the computer’s hard drive rather than on a CD drive or some networked location. 

2 If the chart is not visible, ensure that the Graphics Display is centered within the limits of 
the chart. See the section on Chart Configuration below for more details. 

3 There is a limit to the scale at which raster charts can be viewed in the Graphics Display. 
This scale limit changes according to the size of the Graphics Display window. Above a 
certain scale, raster charts may not be visible. You may have to re-size the Graphics 
Display or change the scale to a smaller numerical value in order to view the chart. 

4 All other selected Graphics Display elements display on top of the chart background. 
Some details may be invisible if the chart is of the same color as the selected option. 

5 It is assumed that the chart datum is the same as configured in WinFrog’s Geodetics. WinFrog 
will not adjust or convert the chart’s coordinates if WinFrog’s Geodetics are changed. This is a 
very important detail. The use of charts that are referenced to a different geodetic datum can 
cause very large positional errors. (See the Chart Information paragraph immediately below 
for details on determining the datum of a NOAA raster chart.) 

Note: When loading a BSB file that is rotated at a non-zero rotation angle, and viewing it at 
small scales, some clipping of the edge of the chart may be apparent in the Graphics 
window when you pan across the window. This is to allow efficient drawing of the chart. 

 

Raster Chart Options in the Chart Configuration Dialog Box 
The Chart Configuration dialog box (as seen below) contains two options that can provide you 
with valuable information about the currently loaded raster chart: Chart Info and Overview. 
(See the section above named To Display a Raster Chart for details on accessing the Chart 
Configuration dialog box.) 
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Chart Info button Displays the Chart Information dialog box. An 
example of the information provided for 
BSB/NOAA Raster charts is shown below. 

 

The Chart Information dialog box displays a variety of important details about the loaded 
NOAA Raster chart including the Geodetic Datum that the chart refers to, as well as to which 
Sounding Data the displayed depths refer.  

This dialog box also provides you with the geographical coordinates of the Limits of the chart. 
This information can assist you in “finding” the chart in the Graphics display. 

Select the Copy Position button to have WinFrog calculate the chart’s center coordinates and 
copy them to the computer’s clipboard memory. 

To Center the Graphics Display at the Middle of the Chart 
1 Choose Configure > Graphics from the main menu. 

2 On the Center tab, select the Center on Position radio button.  

3 Highlight the coordinates and, with the mouse pointer still within the coordinate entry 
window, right-click. 

4 Select Paste. 
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Note: the coordinates now change to the calculated chart center.  

5 Click OK to close the Configure Graphics dialog box and enact the changes. 

More options on the Chart Configuration dialog box: 

Overview button Click this button to display the extents of the 
loaded chart in a size-reduced Overview 
window. Click anywhere within the chart limits 
to see that position’s geographical coordinates. 

 Note: this option is only available when using 
BSB/NOAA charts. 

 Click OK to close this window and return to the 
Chart Configuration dialog box. 

 
Find Chart button Select this option to load a new chart. 
 Note: this feature is detailed earlier in this 

chapter in the section named To Display a 
Raster Chart. 

Troubleshooting Chart Problems 
Chart does not display, even when the vehicle’s position is within the boundaries of the 
chart and the Graphics Display Scale is the same as the natural scale of the chart.  

Ensure that WinFrog’s Geodetics have been properly configured for the current position. Check 
the Geographical and Projection Grid lines in the Graphics Display and ensure that, with 
zero degrees display rotation, the lines run straight vertically and horizontally. If these lines are 
not straight, it is possible that the geodetics are configured incorrectly. 

During WinFrog installation, the message “Chart.dll cannot be registered” is displayed. 

Ensure that you are logged on to WINNT with administrative privileges while installing 
WinFrog. 

Unable to open RMI PCX charts.  

Ensure the correct directory is entered for the Chart working directory. 

WinFrog runs very slowly when the charting option is selected.  

Charting requires at least 32 megabytes of RAM under NT. For tight memory use, the RMI 
PCX charts may provide a performance improvement. 
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Blue Marble Map File Support  
WinFrog can be configured to display a Blue Marble Map (BMM) file comprised of different 
layers of raster and vector maps. 

The following raster file types are supported: 

 JPEG - Joint Photographic Experts Group (. JPG) 
 Supports JFIF compliant files. TIFF - Tagged Image File Format (. TIF) 
 Supports TIFF Specification 5.0 files. 
 Supported Compression Types: no compression, packbits, Modified Huffman 

encoding, CCITT Group 3 1D, CCITT Group 3 2D, and CCITT Group 4 
 Supported color formats: monochrome, 256 color, grayscale, and 24 bit 

 Windows Bitmap (. BMP, .DIB) 
 Supports 1, 4, 8, 24 bit images in Windows or OS/2 format files.  Run Length 

encoded files are not currently supported. 

The following vector file types are supported: 

 AutoCAD DXF (. DXF) Release 14 and earlier 
 AutoCAD DWG (. DWG) Release 14 and earlier 
 ESRI Shape File (. SHP) 
 MapInfo Vector (. MIF) 
 Microstation (Bentley Systems) DGN (. DGN) files. 
 Blue Marble Layer (. BML) 

In practical terms, the use of multiple layers of raster and vector files as background layers 
should be cautioned. This BMM file setup may result in performance degradation in updating 
the Graphics display in real time. For instructions on creating a BMM file, see the Map Wizard 
section in the Utilities chapter. A shortened version of the same wizard is available through the 
Configure Graphics dialog. See the To Create a new Blue Marble Map File section below.     

To Display a Blue Marble Map File 
1 From the Configure menu, choose Graphics. 

2 On the Background tab of the Configure Graphics dialog box, select the Plot Map 
checkbox to enable the display of Blue Marble Map (BMM) files. 

3 Click the Open button to open a BMM file to display as a background image in the 
Graphics window. A BMM file must first be created using the Map Wizard as described in 
Chapter 11 – Utilities.  

4 Select the BMM file to open from the File Open dialog. 
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5 A Map Preview dialog opens with an overview display of the BMM file. Please ensure that 
the BMM file and layer files that are attached to it were created in the same coordinate 
system and units as the settings in WinFrog. If this is not the case and the coordinate 
systems or units are not the same, click the Cancel button and select another BMM file or 
change the WinFrog geodetics configuration. Refer to Chapter 3 – Geodetics & Units for 
information on changing WinFrog geodetics. Note that if the systems differ and you open 
the file, the results will be unpredictable and any resulting image will be inaccurate. 

 Depending on the file format used, some layers and feature types may not be fully 
supported by the Blue Marble library. It is important to verify the integrity and 
completeness of the imported file. Also, care must be taken with the chosen background 
color. If features are the same color as the background color, they will be masked and will 
not be visible. 

Upon previewing, if you find it is necessary to change the scale of the map view, enter a 
new scale and click the Set Map Scale button.  

Click OK if you are at the desired map view scale. 
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6 Click OK on the Configure Graphics dialog box to use this BMM file as a background 
map. 

When a BMM file is displayed in the Graphics window you can verify the name of the BMM 
file being displayed. This is done through the Graphics window pop-up menu. Right-click in the 
Graphics window to access the Map File Name option to view the name and path of the 
currently displayed file. 

To Create a New Blue Marble Map File 
Follow the steps below to quickly create a Blue Marble Map for one supported file. 

1 From the Configure menu, choose Graphics. 

2 On the Background tab of the Configure Graphics dialog box, select the Plot Map checkbox. 

3 Click the New button. This will open the following dialog. 
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Use the Browse button to select a supported file. Click OK to create a new Blue Marble Map 
using the input file and to display it as the background map. 

User Drawing Support 
WinFrog offers the ability to draw graphic objects on the background in the Graphics window. 
The graphic objects can be drawn on: (1) an existing BMM file background, (2) an existing 
Blue Marble Layer (BML) file, or (3) a new, empty background. The following sections provide 
instructions for drawing objects in each of these scenarios. 

User-drawn objects can be saved as a Blue Marble Layer (BML) file for use as a background 
layer in the Graphics window, or appended to an existing BML file. See To Save Graphic 
Objects to a Blue Marble Layer File. 

The drawing options can be accessed in two ways: through the Draw menu, or through the 
drawing shortcut buttons on the toolbar. The toolbar buttons are: 

 
1 Stop Drawing 
2 Select Object 
3 Draw Point 
4 Draw Polyline 
5 Draw Polygon 
6 Draw Text 
7 Draw Circle 
8 Draw Arc 
9 Draw Polyarc 

Once object are drawn, certain attributes, such as line color, can be edited. See To Edit User-
Drawn Graphic Objects later in this chapter. 

To Draw Graphic Objects When a Blue Marble Map (BMM) File is Displayed 
1 Display a BMM file. For steps on how to display a BMM file in WinFrog, see the Blue 

Marble Map File Support section above. 

2 Select the appropriate toolbar button or Draw menu option for the graphic object you which 
to draw. 

3 Position the mouse pointer on the Graphics window and click. The graphic object will be 
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added at this position. For a Point object, a point symbol will be added at this location. For 
the Polyline, Polygon, Circle, Arc and Polyarc objects, the vertex of the specified object 
will be added. For the Text object, you will be prompted to enter the text for the specified 
location. 

4 Repeat step 3 for each vertex in the Polyline, Polygon, Circle, Arc and Polyarc objects. 

5 Once the object is drawn, select Draw > Stop Drawing, or click the Stop Drawing toolbar 
button, or right-click and select Stop Drawing from the pop-up menu. 

To Draw Graphic Objects on an Existing Blue Marble Layer File (BML) 
1 From the Configure menu, choose Graphics. 

2 On the Background tab of the Configure Graphics dialog box, select the User Draw 
checkbox to enable the Open and New buttons.  

3 Click the Open button to open a BML file to display as a background layer in the Graphics 
window.  

 

4 A Check Layer Coordinate System dialog opens with the WinFrog and BML Map file 
coordinate systems and units displayed. Click OK to proceed to the next step or Cancel if 
the displayed geodetics and units do not match. If the two geodetic systems differ, either 
select another BML file or change the WinFrog geodetic configuration. Refer to the 
Geodetics & Units chapter for information on changing the WinFrog geodetics. 
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5 A Layer Preview dialog opens with an overview display of the BML file. Click OK to 
display this file in the Graphics window or click Cancel to cancel this operation. Once the 
file is displayed in the Graphics window, you can follow the steps in the above section to 
draw graphic objects on this background. 

To Draw Graphic Objects on an Empty Background 
1 From the Configure menu, choose Graphics. 

2 On the Background tab of the Configure Graphics dialog box, select the User Draw 
checkbox to enable the Open and New buttons. 

3 Click the New button to create a new background image in the Graphics window.  

4 A WinFrog Coordinate System dialog box displays with the current WinFrog geodetics 
selected. (See Chapter 3 – Geodetics & Units for information on setting geodetics.) This is 
dialog is informative only – you cannot change the settings. Click OK to proceed to the 
next step. 

 

5 A Map Coordinate System dialog opens to configure the BML map file coordinate 
system. Set the BML file geodetics to the WinFrog geodetics from the previous step – this 
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is very important, as incorrect settings will cause inaccurate results. Click OK to proceed to 
the next step or Cancel to cancel the operation. 

Note: The BML file Geodetics should be set for the hemisphere that the active survey is 
being performed. In this example, use 11N for operations in the Northern Hemisphere and 
11S for operations in the Southern Hemisphere for the UTM zone. 

 
 
6 A Check Map Coordinate System dialog opens with an overview display of the newly 

created BML file in the top portion of this dialog and the WinFrog and BML Map file 
coordinate systems and units displayed in the bottom. Click OK to proceed if the coordinate 
systems and units match, or click Cancel to cancel this operation. 

 

7 Click OK on the Configure Graphics dialog box. You can now draw graphic objects on 
this newly created background.  
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To Save Graphic Objects to a Blue Marble Layer File 
1 When finished drawing the graphic objects you wish to create, select Draw > Save. 

2 The Save User Drawing dialog box displays. Select the Save radio button. 

3 A Save As File dialog box displays. Specify the name and location where the BML file will 
be saved. 

4 The Map Coordinate System dialog box displays. Confirm that the Map Coordinate 
System geodetics are the same as the WinFrog geodetics. Click OK to create the BML file. 

Creating and saving a BML file in this manner saves the file as an independent BML file, with 
the .bml file extension. Any BML files created can be displayed as a standalone background 
layer in the Graphics window or added as a layer into a new or existing BMM file. 

Note: Saving graphic objects into an existing BML file will overwrite the file and you will 
lose all previously saved objects. See the instructions in the following section for appending 
objects to an existing BML file. 

To Append Graphic Objects to a Blue Marble Layer (BML) File 
1 When finished drawing the graphic objects you wish to create, select Draw > Save. 

2 The Save User Drawing dialog box displays. Select the Append radio button. 

3 An Open File dialog box displays to select an existing BML file to which to append the 
additional graphic objects. 

To Edit User-Drawn Graphic Objects 
Certain attributes of user-drawn graphic objects can be edited, based on the type of object. 

1 Click the Select Object  button on the toolbar and then click on the object you wish to 
edit. The object color changes to show that it is selected. 

2 Right-click in the Graphics window and select Edit Drawing from the pop-up menu. A 
dialog will display with editing options based on the object selected. 

Editing options for graphic objects: 

Polyline, Polygon, Circle, 
Arc and Polyarc Color 
Text Text and text color 
Point Color, size and icon 

Note: When editing the size of the Point object, 
a negative value indicates that the size is in 
pixels and the object size remains fixed when 
the map scale is changed; a positive value 
indicates that the size is in map units and the 
object size will change scale with the map when 
you zoom in or out; a size of zero (the default 
value) indicates that the bitmap is shown at its 
normal size. 
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3 Make your editing selections and click OK to exit. 

Objects can also be deleted from the Graphics window pop-up menu. Select an object, right-
click and choose Delete Object. 

Displaying a C-Map Vector Chart in WinFrog 
When you first install WinFrog, there are two installation options, Typical and Custom. 
Choosing a Custom installation provides you with the option to configure WinFrog to display 
C-Map files. You MUST choose this option in order to display C-Map files. If you did not 
initially install WinFrog using the Custom installation options, WinFrog must be removed and 
then reinstalled.  

Note: C-MAP charts are purchased directly from C-MAP. 

Note: WinFrog only supports C-MAP CM-93 Edition 2. 

By default, C-MAP charts use a Mercator map projection to convert the geographical 
coordinates to grid coordinates. If a project requires it, the charts can be displayed using 
different geodetic parameters. See the section titled To Use WinFrog’s Map Projection below. 

Note: RML, HDR and BSB format raster charts cannot be displayed when the C-MAP display 
option is selected. WinFrog must be removed and then reinstalled in order to display these 
types of Raster charts. Other chart file types supported by the Blue Marble GeoView Library 
(JPG, BMP, TIF and GEOTIFF raster files and DXF, DWG, SHP, MIF, DGN, and BML vector 
files) can be displayed (as a layer in a BMM file) when the C-Map display option is selected. 

To Display a C-Map Vector Chart  
1 Insert the C-Map CD containing the region to be displayed.  

2 Launch WinFrog. 

3 From the Configure menu, choose Graphics to bring up the Configure Graphics dialog. 

4 Select the Background tab. 

5 Select the Plot Charts checkbox, then click the Chart Options button to display the C-
MAP Configuration dialog as seen below. 
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6 In the CMAP Root Directory field (at the bottom of the CMAP dialog box), make sure the 
drive letter corresponds to the CD ROM drive containing the CMAP CD. 

7 Click the Zone button to bring up the Zone Selection dialog box, as seen below. 

 

8 Select a zone by double-clicking within its boundaries. 

 

 

The Zone Select dialog box opens, asking you to confirm the selection. 
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9 Click Yes or click No and repeat Step 6. 

10 Click OK. Another Zone Select dialog box opens. 

 

11 Click Yes or click No and repeat Step 6. 

The User Code dialog box opens, displaying the following message: “Your User Code is 
X. Contact C-MAP with this user code to receive an authorization code.” 

12 Click OK. 

13 Once the Authorization Code is obtained, enter it in the Authorization Code entry field. 

14 Click the ACTIVATE button. 

 

15 Click Yes to confirm the change. 

16 Click OK to close the CMAP Configuration dialog box. 

17 Click OK to close the Configure Graphics dialog box and display the C-Map vector 
chart. 

C-Map Vector Chart Feature Levels 
C-Map Vector chart parameters can be modified via the CMAP Configuration dialog box. 

When the Auto Select Level Base on Scale box is checked in the CMAP Configuration dialog 
box, the precision of the map displayed is related to the value entered by you in the Scale 1: 
entry field at the top of the Configure Graphics dialog box. 

Scale Feature Level ID Precision Values 
>5,000,000 Background Map W not available 
5,000,000 World Map A 1500m 
1,500,000 General Nautical B 450m 
500,000 Coastal C 150m 
150,000 Coastal Approach D 45m 
50,000 Approach E 15m 
15,000 Harbor F 4.5m 
5,000 Plan G 1.5m 

 
The letter ID in the Feature Level area of the CMAP Configuration dialog box shows the 
feature level displayed in the Graphics window. If there is no chart available with the feature 
level corresponding to the user-entered scale, the Graphics window displays in white. 
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To Bypass the Default Precision Value Associated with an Entered Scale 
1 Uncheck the Auto Select Level Base on Scale box in the CMAP Configuration dialog 

box in order to display a desired feature level despite the entered scale. 

Note: a high precision feature level displayed at a high scale can adversely affect 
performance while a low feature level displayed at a low scale can result in a loss of 
precision. 

To Use WinFrog’s Map Projection 
By default, these charts are displayed using a Mercator map projection. You can choose to 
display the charts using the parameters configured in WinFrog’s Geodetics dialog box instead. 

1 In WinFrog, select the main menu item Configure > Geodetics, then configure the geodetic 
parameters, as required. See the Configuring Geodetics and Units chapter for more 
information on selecting the Working Geodetics in WinFrog. 

2 In the CMAP Configuration dialog box, un-check Mercator. 

Note: CMAP display performance is greater when the Mercator box is checked. 

Visible Illuminations 
Light sources shine a light toward the sea. However, obstacles can block the beam of light in 
certain directions. Vector maps can indicate where a vessel would be able to see a beacon of 
light shining from a lighthouse or other light sources. 

To Indicate Illumination 
1 Check the Show Lights box in the Feature Level area of the CMAP Configuration dialog 

box. 

Profile Window 
The Profile window displays a user-defined view of the water column and can include such 
information as survey lines and waypoints as well as all WinFrog vehicles. In addition, if a 
DTM is loaded, the profile created where the Profile Window cross section intersects the DTM 
can be displayed. 

Note: The use of a DTM to display a profile requires the MBES Logging module. 

The inclusion of the above mentioned data in the Profile window is dependent upon the 
location of the various data relative to the configured location as well as the orientation of the 
Profile window. The following sections detail the configuration of the Profile window. See the 
Working Files chapter for more information on configuring three-dimensional survey line and 
waypoint data. 

To Display the Profile Window 
1 From the View menu, choose Profile. Multiple Profile windows can be displayed 

simultaneously, each with their own unique configuration. Each Profile window can be moved 
or have its size altered by “grabbing” the edge of the window and moving it as desired. 
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There are a variety of Profile window operation and configuration options presented when 
the mouse pointer is moved into the limits of the Profile window and the right mouse 
button is clicked. Most of these options are also presented in the Profile window Toolbar 
found at the bottom of the Profile window. 

For typical, real world operations you would first configure the Profile window. 

 

To Configure the Profile Window 
There are three ways to access the Configure Profile dialog box. 

1 Select Configure > Profile. 

2 Move the mouse pointer within the limits of the Profile window, right-click and select 
Configure Profile. 

3 Select the Config button in the lower right corner of the Profile window on the toolbar. 

Regardless of the method used, the result is the presentation of the Configure Profile 
Window dialog box. 

The Configure Profile window is comprised of five different configuration categories that are 
accessed by selecting the appropriate tab. Each of these configuration options is detailed below. 
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Position Tab 
The Position tab allows you to specify the way that the Profile window is centered 
horizontally. 

 

Fixed radio button Select this option to horizontally center the 
Profile window at the coordinates displayed in 
the box, regardless of the current vehicle 
position. The coordinates can be either entered 
in geographic latitude and longitude (if the Geo 
radio button is selected) or in grid Northing and 
Easting (if the Grid radio button is selected). 

Vehicle radio button/ 
dropdown box Select this radio button, then (from the 

dropdown box) choose the vehicle to which the 
Profile window display will be horizontally 
centered. 

Re-Center Percent field Enter a value in percent. This is the percentage 
of the distance between the center and the side 
edge of the display in which the current vehicle 
is permitted to travel before the Profile window 
is refreshed. When the current vehicle comes 
within the re-center percentage limits of the 
Profile window edge, the Profile window pans 
to return the current vehicle to the center 
(horizontally) of the Profile window. 

Window Tab 
The Window option allows you to control the Horizontal Scale, Vertical Scale, and 
Orientation of the data in the Profile window. 
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Width Control 
Automatically matched to  
Vertical Scale If selected, WinFrog automatically varies the 

length (width) of the Profile window to match 
the Vertical Scale. 

Fixed Length, stretches  
with window size If selected, allows you to manually define the 

length (width) of the Profile window. It is 
recommended that this option is selected to 
ensure the adequate horizontal information is 
visible, despite the fact that the display will not 
be to scale. 

Vertical Control 
Top Elevation/Depth Enter a value to define the top of the water 

column displayed in the Profile window. This 
value designates where the top of the Profile 
window begins in relation to the surface of the 
water. The value 0 starts at the surface. A 
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negative value starts below the surface. It is 
suggested that a value of approximately 20 
meters is entered to ensure that surface vehicles 
will be visible in the Profile window. 

Total Vertical Range Defines the total amount of the water column 
displayed in the Profile window, as measured 
down from the Top Elevation entry made 
above. This range is always entered as a positive 
value. 

Orientation 
You can only select a profile orientation for the projected type of profile; see the Display 
tab. The orientation may be fixed, i.e. with respect to north or may be related to a vehicle.  

Fixed azimuth of  
Profile Window Select this radio button to fix the profile’s 

orientation with respect to north. 
Azimuth of Window  
left to right Enter the Azimuth (horizontal bearing) of the 

Profile display as it appears in the Graphics 
window. 

 
To determine the Azimuth, visualize that you are looking straight down from high above 
the ocean surface and the Profile location. From this perspective, the Profile will appear 
simply as a thin straight line, the length as defined in the Width Control entry above. 

To define the Azimuth of the Profile line you must first decide from which side you wish 
to view the Profile (i.e. decide which end of the Profile will be to your viewing left and 
which side will be to your viewing right as you look horizontally at the mid-point of the 
Profile). The Orientation value entered here is the bearing of the line created by joining 
the left edge of the display to the right side of the display. 

Typically, to view a Survey Line in profile view without scale distortion, the Orientation 
value will be the bearing of the Survey Line segment (or 180 degrees different, depending 
on how the Survey Line coordinates were entered). 

Note: if Continuous Profile along selected line is chosen from the Display section 
(detailed in the section below), the Orientation entry window will display Along whole 
line, and not allow any numerical data entry. 

Vehicle Based orientations: 
Forward The profile will be perpendicular to the vehicle’s 

heading and as if the viewer was facing forward, 
towards the bow, from the center of the vehicle. 
Thus the right hand side of the profile will be to 
the starboard side of the vehicle. 

Aft Similar to above, the profile will be 
perpendicular to the vessels heading, but as if the 
viewer is facing aft. Thus the right hand side of 
the profile will be to the port side of the vehicle.
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Port The profile will be parallel to the vehicle’s 
heading and as if the viewer was facing port, 
from the center of the vehicle. Thus the right 
hand side of the profile will be to the forward 
part of the vehicle. 

Starboard Similar to port, the profile will be parallel to the 
vehicle’s heading and as if the viewer was facing 
starboard, from the center of the vehicle. Thus 
the right hand side of the profile will be to the aft 
part of the vehicle. 

Bearing from bow… Instead of using cardinal points above, you may 
select an angle from the bow that you want the 
profile to lay at. The right hand portion of the 
profile is in the direction of the entered angle. 

Redraw Tolerance Since vehicle based orientations will change as 
the vehicle heading changes, a tolerance has 
been added to prevent continual redraws. Once 
begun, the vehicle heading must change by the 
amount entered before a redraw will occur. 

Display Tab 
The Display option provides you with the ability to configure various Profile Display features. 
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Profile Type 
Projected Profile Select this option to allow manual configuration 

of the Window Tab options, as detailed 
immediately above. This type of profile is a 
cross section. The extent of the cross section is 
displayed in the Graphics window. 

Continuous Profile along 
selected line  Select this option to have WinFrog 

automatically control the Profile orientation to 
suit the currently selected survey line, as 
detailed below. This type of profile is a center 
line profile of the line assigned to the vehicle 
selected on the first tab. A vehicle must be 
selected on the first tab. This profile is always 
drawn from the start of line on the left. 

Feature Display Control 
Draw Lines /  
Draw Waypoints Select the appropriate checkbox to draw lines 

and/or waypoints. These options enable the 
display of all contents of the appropriate 
Working file.  

Select Survey Line to be Displayed 
dropdown box This selection is applied only when the Profile 

Type is Continuous Profile along selected 
line. This option allows for the Profile display 
of an alternate Survey Line, perhaps one that 
contains more downline elevation information, 
such as slope changes for example. 

 If the real-time Cable Model is not running, this 
option defines the line for the Profile window. If 
the real-time Cable Model is running, the 
Profile window is defined by the survey line 
being tracked by the first surface layer vehicle.  

DTM Profile Display 
This group is only enabled if a DTM (multibeam coverage map) has been loaded. It will 
enable the drawing of the profile of either the cross section or vehicle track line where it 
intersects the DTM.  

Display Cross Section  
Profile  If the Projected Profile has been enabled you can 

display the profile of this cross section where it 
intersects the DTM. The cross section line is 
displayed in cyan in the Graphics window. 

Display Profile of selected 
Vehicle’s Track Line This will allow you to draw the selected 

vehicle’s track line profile where it intersects the 
DTM. A vehicle must be selected on the first tab 
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and it must have an assigned survey line. The 
profile is drawn in terms of along line distance, 
from left to right, across the Profile window. 

Profile Resolution  This is the resolution (distance between points) 
to use to interrogate the DTM to construct the 
profile. It shouldn’t be any less then the cell 
size; the minimum interval is 0.25m. 

Profile Color  This is the color that the profile will be drawn in. 
Click the Edit Color button to change it. 

General 
Refresh Rate (Hz) Enter a value that configures the rate at which 

WinFrog will refresh the Profile window 
display. The default value of 5.0 Hz should be 
adequate for most applications.  

 Note: Do not enter too small a value, as the 
constant regeneration of the Profile window will 
slow the program. 

 

Options Tab 
The Option dialog box provides you with the ability to control three Profile window 
options, as detailed below. 

 

Number of Points to 
Compute Instantaneous 
Slope Enter a value (between 2 and 100) that defines the 

number of real-time echosounder observations 
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(soundings) that will be used to determine the 
slope of the seabed. This value is applied only if 
Real-Time Slope Monitoring is enabled. 

Use Offset Position for 
Displaying Cable Source Select this option to enable a shift in the position 

that the echosounder data are plotted to the 
vessel’s Tracked Offset position (i.e. the Stern, 
for example), as opposed to the vessel’s CRP 
position. This visual adjustment to the real-time 
sounding data makes no notable difference to 
calculations in deeper water depths. 

Display Toolbar Select this option to enable the display of 
various Profile window slope measurement 
and display movement tools in the bottom of 
the Profile window. These toolbar options are 
detailed in the section below named Profile 
Window Toolbar. 

Surveyed Soundings Tab 
The Surveyed Soundings dialog box allows you to configure the display of Pre-lay 
Sounding data from a previously recorded Database (.mdb) file, as detailed below. 

 

Display Soundings from  
Database Select this option to enable the display of 

sounding data contained in a .mdb format file. 
Browse Select this button to navigate to the appropriate 

directory and select the desired .mdb file. 
Edit Color Select this button to change the color in which 

the loaded database soundings are plotted in the 
Profile window. 
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The Import Bathymetry utility (Utilities > Import Bathymetry) converts ASCII x,y,z 
bathymetry data into a WinFrog formatted soundings database file that can be displayed in 
the Profile window. To learn more about this utility refer to chapter 11: Utilities. 

Profile Window Toolbar 
At the bottom of the Profile window is a toolbar that provides you with shortcuts to seven 
different Profile window configuration and measurement functions. Several of these functions 
can also be accessed by right-clicking when the mouse pointer is located within the limits of the 
Profile window display. The following sections detail each of the toolbar items, in the order 
that they are found at the bottom of the Profile window. 

 

Set Cursor 
Selecting this button enables you to define the point from which slope measurements will be 
made, i.e. where the slope will be anchored. This function is the same as the Anchor Cursor 
feature found in the “right-click menu” accessed while your cursor is in the Profile window. 

To set the cursor, select this button (“graying” out the button text), then move the mouse 
pointer to the desired location in the Profile window and click. A “cross’ will appear in the 
Profile window at the specified location. 

Slope 
Select this button to define the point to which slope measurements will be made, i.e. from 
where the slope was anchored (see above) to this new location. This function is the same as 
the Measure Slope feature found in the “right-click menu” accessed while your cursor is in 
the Profile window. 

To measure slope, select this button (“graying” out the button text), then move the mouse 
pointer to the desired location in the Profile window and click the left mouse button. A line 
will now appear, connecting the previously set “anchor” position to this new point. 
WinFrog displays a variety of information related to this measurement in the bottom left 
corner of the display area below the Vehicle Text window. 
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As shown above, WinFrog calculates and displays the To Point KP value, the slope measured 
in degrees, and the measured slope percentage. 

Snap Data 
Select this button to instruct WinFrog to “snap” to an existing plotted sounding to which 
slope measurements will be made. This selection precludes the manual definition of a “To” 
point as defined above. 

Go Left 
Select this button to instruct WinFrog to move the viewer’s perspective of the Profile 
window to the left, i.e. moves the contents incrementally to the right. 

Go Right 
Select this button to instruct WinFrog to move the viewer’s perspective to the right, i.e. 
moves the Profile window contents incrementally to the left. 

Go Up 
Select this button to instruct WinFrog to move the viewer’s perspective “up”, thus moving 
the Profile window contents incrementally “down.” 

Go Down 
Select this button to instruct WinFrog to move the viewer’s perspective “down”, thus 
moving the Profile window contents incrementally “up.” 

Config 
Select this button to access the Configure Profile window dialog box, as detailed at the 
start of the Profile Window section. 
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Vehicle Text Window 
The Vehicle Text window displays real-time information for all vehicles in text form. This 
information can include the vehicle’s Name, Position, Heading, and Speed, as well as a host of 
other data. You can display more than one Vehicle Text window at a time, with each Vehicle 
Text window configured differently than the others. 

As well as displaying navigation data, the Vehicle Text window provides quick access to 
several commonly used WinFrog setup and configuration menus, including Automatic Event 
Configuration, Vehicle Offset, Vehicle Device Configuration, Line Tracking, Vehicle 
Presentation, and Waypoint Tracking. The event configuration item will only be present if 
the vehicle displayed in the Vehicle text window is the primary event vehicle. 

To View the Vehicle Text Window 
1 From the View menu, choose Vehicle Text. The Vehicle Text window opens at the bottom 

of the WinFrog work area, as seen below. 

 

WinFrog carries a default configuration of the Vehicle Text window contents for the initial start 
up. The data displayed in this window (and the location of data items in the window) is 
configurable as detailed below. All modifications to the Vehicle Text window are saved in the 
WinFrogini.wfg file when the program is exited correctly. 

To Configure the Vehicle Text Window 
1 Select the main menu item Configure > Vehicle Text or move the mouse pointer into the 

Vehicle Text window and right-click then select Configure Vehicle Text from the 
presented menu options. 
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This window allows you to select which data items are displayed in the Rows and Columns of 
the Vehicle Text window, as well as the Font Size and Alignment of the selected data text. 

Note: Row 1 refers to the top row of the Vehicle Text window. 

Window Control 
Rows/Columns Enter the number of rows and columns (1 to 5) that 

you want to display in the Vehicle Text window. 

Text Alignment 
Left/Center radio buttons Select the desired alignment option. 
 
Window Always on Top Select this option to ensure that the Vehicle 

Text window always displays on top of any 
overlapping windows. This ensures that the 
more important information found in the 
Vehicle Text window is always visible. 

Data Display Control 
Row dropdown Use the dropdown menu to select the row that 

you want to modify. 
Line Contents box Lists the items currently displayed in the 

selected row of the Vehicle Text window. 
 To add items to this list, first ensure that the 

desired row is selected. Next, select the desired 
item listed in the Available Items box and click 
the left arrow. This adds the selection to the 
Line Contents box and removes it from the 
Available Items list. 

 To remove contents from the Line Contents 
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box, select the desired item and click the right 
arrow. This removes the item from the Line 
Contents box and adds it (in alphabetical order) 
to the Available Items list. Each item can be 
listed only once in the Vehicle Text window. 
Note: some items may appear as blank boxes in 
the Vehicle Text window until valid data exists 
for that field. For example, by default, Row 4 is 
configured to display waypoint tracking data 
(Wpt Name, Wpt Range, Wpt Bearing). If no 
waypoint is being tracked, these three data items 
will remain blank. 

Font Size Select the size of the font used to display items in 
the row number shown in the Row dropdown list. 

Available Items 
The items available for display in the Vehicle Text window are listed. When selected by using 
the left arrow they are removed from this list and appear in the Line Contents list for the 
selected row. 

Note: If a plow device is providing tension at the plow, this tension is the item 
CABLE Plow TOW Tension if it is also providing tension at the ship (either as 
part of the telegram or from a selected counter device) the tension at the ship is 
CABLE - TEL Tension (Ch1). 

 
To Remove a Vehicle’s Data from Display in the Vehicle Text Window 
1 Select the main menu item Configure > Vehicles > Vehicle Presentation > Vehicle 

Window Data > Off.  

Acoustics Window 
The Acoustics Window provides you with the means to configure and monitor all aspects of 
the WinFrog acoustic operation. This window supports multiple sub-windows that provide these 
features for different parts of the acoustic operation. 

To Display the Acoustics Window 
1 From the View menu, choose Acoustics 
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This window provides access to the configuration options and sub-windows from the 
three menu buttons located at the top of the window. 

Working Files Options 
You are able to work with transponder and velocities files directly from the Acoustics 
Window using the File menu item. This is a more efficient process than using the WinFrog 
main menu File item. 

New 
Click the File item, select New and you are able to select either Xponders or Velocity. 
Choosing either one moves you directly to the new Xponders or Velocities window. 

 

Proceed from this point as described in the Working Files chapter for Xponder and 
Velocity files. 
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Set To Working 
This option allows you to directly set a selected Xponders or Velocities file to be the 
Working version.  

Click the File item, select Set to Working and then select either Xponders or Velocity. 
Choosing either one moves you directly to the browse dialog showing only the appropriate 
file types. Select the desired file and click OK. The selected file is automatically set to be 
the Working copy. 

Note: If there is currently a Working Xponders file, you are alerted to this and the 
operation is aborted. If this occurs, you must open the current Working Xponders file and 
un-check the Working checkbox and exit with OK. Now a new Working Xponders file can 
be set. This check is not currently implemented for the Working Velocities file. 

Edit 
This option allows you to directly access the current Working Xponders or Velocities files 
for editing. Click the File item, select New and you are able to select either Xponders or 
Velocity. Choosing either one moves you directly to the Xponders or Velocities window. 

 

Proceed from this point as described in the Working Files chapter for Xponder and 
Velocity files. 

Direct Configure Options 
From the Configure menu item, you are able to select the vehicle with which to associate the 
acoustic calibration features and configure and control the acoustic calibration. 

Select Vehicle for Calibration 
This option allows you to select the vehicle with which the window will associate all 
acoustic calibration control and monitoring.  

Click the Configure item, select Select Vehicle for Calibration and you are able to select 
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from a pop up list of all vehicles with either an LBL TRANSCEIVER or USBL 
HYDROPHONE data type attached to it. Select the appropriate vehicle. 

In subsequent repeats of the aforementioned steps, the selected vehicle is displayed with a 
checkmark beside its name. 

Note: This setting is not saved when the Acoustics Window is closed. 

Calibration 
This option provides direct access to the Calibration dialog for the selected vehicle. If a 
calibration vehicle has not been selected, you are so informed and the Calibration dialog is 
not accessed. 

Click the Configure item, select Calibration. 

 

Proceed from this point as described in the Acoustic Calibration chapter. 

Viewing Windows 
The Acoustics Window allows you to access several windows that provide the means to 
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monitor the WinFrog system and operation as it pertains to acoustics. Some of these support 
direct access to the configuration of the WinFrog components they are monitoring. 

These windows are accessed from the View menu item. The following sections detail each 
available window. 

System Status 
This window presents a summary of the WinFrog system as it relates to acoustic operations. 
The information is constantly updated and reflects the current respective configurations and 
information. 

Click the View item and select System Status. 

 

This split window presents the configuration of WinFrog in a tree format in one panel and 
data in the other panel. The split can be configured to vertical or horizontal via a pop-up 
menu using the right mouse button in the tree section. The font used in the data section can 
be modified via a pop-up menu using the right mouse button in the data section. 

The tree nodes include icons to indicate an appropriate status. 
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ACOUSTIC DEVICES Node 

 

This node lists all the LBL and USBL acoustic devices that have been 
added to WinFrog. The devices are listed with an icon indicating the 
status of the serial port. Each device node can be expanded to list the 
data types associated with it. 

Select a device and click the right mouse button to open a pop-up menu 
that presents direct access to the selected devices configuration. 

Note: Devices can not be added to WinFrog from this window. 

For more details, see the I/O Devices Window section in this chapter. 
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POSITION DEVICES Node 

 

This node lists all the position type devices (GPS) that have been added 
to WinFrog. The devices are listed with an icon indicating the status of 
the serial port. Each device node can be expanded to list the data types 
associated with it. 

Select a device and click the right mouse button to open a pop-up menu 
that presents direct access to the selected devices configuration. 

For more details, see the I/O Devices Window section in this chapter. 
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VEHICLES Node 

 

This node lists all the WinFrog vehicles that have an acoustic data type 
attached to them. These nodes can be expanded to list the POSITION, 
LBL and USBL data types attached to the respective vehicle. Note that 
only these data types are listed. 

The data type nodes include an LED indicating the status of that data 
type’s position calculations. A yellow LED indicates that the status is 
unknown or the position calculation was successful but the result was 
gated. A red LED indicates that the position calculation failed. This 
failure may be due to insufficient data. A green LED indicates that the 
position calculation was successful and accepted. 

Select a data type and click the right mouse button to open a pop-up 
menu that presents direct access to the selected data type configuration. 

For details on configuring the data types, see the Vehicle Data Source, 
LBL Operation and USBL Operation chapters. 
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CALIBRATION Node 

 

This node summarizes the calibration status for the vehicle selected for 
the calibration for the window (see Select Vehicle for Calibration). 
The primary node caption includes the name of the vehicle selected or 
None if one has not been selected. 

The node can be expanded to provide details on the calibration. For 
details on the information displayed here, see the Acoustic Calibration 
chapter. 

Calibration Status 

This node shows the current status of the calibration data 
collection, both with an LED (green, collection is on, red, 
collection is off) but also with an ON and OFF statement. In 
addition, this node can be expanded to show the current 
collection mode. 

Mode This states the current calibration data collection 
mode, either LBL, II, USBL, Baselines or Depths. In 
addition, it includes the status if the collection is 
Paused or Aborting.  

Number of LBL surface range epochs collected 

This lists the total number of surface position and LBL range 
data records in the current calibration data set.  
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Number of baseline records collected 

This lists the total number of baseline observation records in 
the current calibration data set. 

Number of depth records collected 

This lists the total number of depth observation records in 
the current calibration data set. 

Number of USBL records collected 

This lists the total number of surface position and USBL range 
data records in the current calibration data set. 

Calibration File Status 

This node shows the current status of the calibration data file 
with respect to actually being saved to disk. The node LED is 
red if the file has not been saved once. It is yellow if the file 
has been saved at least once but there is new data in the data 
set and the file should be saved again soon. The LED is green 
if the file has been saved and is current, that it, there are no 
new data points. 

Name This lists the name of the current calibration data set 
file. 

FILES Node 

 

This node expands to summarize the associated Working Xponders 
and Working Velocities file status. 
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The names of the current Working Xponders and Working Velocities 
files are listed with a green LED associated with each indicating that 
the file is loaded and set to Working. In either case, if a Working file is 
not present, the LED flashes between yellow and red and the message 
>>>LOAD AN XPONDER FILE<<< or >>>LOAD A VELOCITY 
FILE<<< is shown in place of the file name. 

Calibration Status 
This window presents a summary of the current calibration data set for the selected 
calibration vehicle, whether loaded from a file, or currently being collected or any 
combination of these. The window is constantly updated and represents the current status of 
the calibration data set. 

Click the View item and select Calibration Status. 

 

The information is presented in a header followed by four list windows. 

Header 
This section summarizes the overall calibration data information. 
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Data Collection Mode 

This displays the current data collection mode and it status. The 
possible modes are as follows: 

LBL Standard Surface Range 
LBL II Surface Range 
USBL Surface Range 
Baselines 
Transponder Depths 

 
In the case of the first three, the only status is (Active), in the case of 
the last two the status could be (Active) or (Paused). 

Calibration File This gives the path and name of the file 
used for the current calibration data set. 

Created This is the date and time the file was 
created (WinFrog clock). 

Last Saved This is the time the file was last saved 
(computer clock). 

Calibration Start Time This is the time the calibration was 
started (WinFrog clock). 

Last Observation Epoch This is the time the timestamp of the 
last data epoch (WinFrog clock). 

Current Time This is the current time (computer 
clock). 

Surface Range Summary 
This list window summarizes the surface based observations. This 
includes both surface position and LBL range data records and surface 
position and USBL range data records. They are listed by type, name 
and address/beacon code. 

Station Name The stations that have been ranged to as 
part of the calibration data set. 

Type The data type, either LBL, USBL (XYZ) 
or USBL (TWTT). 

Tx The LBL transmit channel or the USBL 
beacon ID. 

Address The LBL address or the USBL beacon 
ID. 

Total # Ranges The cumulative total of the ranges for the 
associated station. 
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# Weighted Ranges The cumulative total of the ranges for the 
associated station that are weighted in the 
solution. 

Baseline Summary 
This list window summarizes all the observed baseline station pairs. 
Any pair is only listed once in the list and includes the forward and 
reverse observations. For a given pair, the From station is assigned to 
the station of the pair that is detected first in the calibration data set 
station information list. 

From Station The From station in the baseline pair by 
name and transponder address. 

To Station The To station in the baseline pair by 
name and transponder address. 

# Fwd Successful The total number of successful forward 
baseline observations. 

# Fwd Failed The total number of failed forward 
baseline observations. 

# Fwd Weighted The total number of forward baseline 
observations weighted in the solution. 

# Rev Successful The total number of successful reverse 
baseline observations. 

# Rev Failed The total number of failed reverse 
baseline observations. 

# Rev Weighted The total number of reverse baseline 
observations weighted in the solution. 

Mean Raw BL The mean of all the weighted raw 
baseline observations. 

Mean Scaled BL The mean of all the weighted scaled 
baseline observations. 

Expected BL The expected baseline distance. 

Depth Summary 
This list window summarizes all the depth observations.  

Station Name, Address The stations that have had depth 
observations made to them. 

# Successful Depths Thenumber of successful depth 
observations. 

# Failed Depths The number of failed depth observations. 
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# Weighted Depths The number of weighted depth 
observations. 

Mean Raw Depth The mean of all the weighted raw depth 
observations. Note that this is the raw 
depth observation and therefore in the 
case of a digiquartz sensor, will be the 
frequency count, not an actual depth. 

Mean Scaled Elevation The mean of all the weighted depth 
observations reduced to a station 
elevation. 

Expected Elevation The respective station elevation as a 
reference for the observations. 

Current Collection Process Summary 
This list window summarizes the current collection process. The 
associated header states the current process type, start time and elapsed 
time. 

The list window itself provides the columns that relate to the respective 
current process. 

LBL Ranging 

Station Name This column lists the station name and 
address of the occupying transponder. 

Data Time  This column gives the epoch of the current 
observation. 

Observed Range 
(TWTT)  This column gives the current raw range, 

that is, the two-way-travel-time in 
milliseconds. 

Red. Range  This column gives the current reduced 
range. 

USBL Ranging 

Station Name This column lists the term USBL and the 
beacon code. 

Data Time  This column gives the epoch of the 
observation. 

Obs. X This column gives the current raw 
observed X value of the USBL data. 

Obs. Y This column gives the current raw 
observed Y value of the USBL data. 
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Obs. Z This column gives the current raw 
observed Z value of the USBL data, except 
that the sign convention has been changed 
to represent the local ship based coordinate 
reference frame in that this Z term is a 
negative. 

Baseline Data 

From Station This column lists the From station in the 
baseline pair by name and transponder 
address. 

To Station This column lists the To station in the 
baseline pair by name and transponder 
address. 

#Obs collected This is the number of forward and reverse 
baseline observations collected. 

Depths 

Station This column lists the station by name and 
transponder address. 

#Obs collected This is the number of depth observations 
collected. 

Raw Obs This column lists the current raw depth 
observation. Note that this is the raw 
depth observation and therefore in the 
case of a digiquartz sensor, will be the 
frequency count, not an actual depth. 

Reduced Elevation This column lists current depth 
observation reduced to a station 
elevation. 

Terminal 
This window enables you to communicate directly with a selected LBL acoustic device 
using a Terminal Window. 

To view, click the View item and select Terminal. While open, this item is displayed in the 
View menu with a checkmark. 

To close, click the View item and select Terminal.  
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From the drop down list of available LBL acoustic devices, select the one to communicate 
with. 

Click the mouse in the terminal section of the window. Enter the command to send to the 
device and hit Enter. While waiting for the response, the terminal section is set to read 
only. When the response is received it is displayed in the terminal section and this section 
becomes active again. 

If a response is not received after 30 seconds, the terminal section is updated to display a 
TIME OUT message and re-activated. 

If the appropriate devices are not available, an appropriate message is displayed in the 
terminal section. 

Calculations 
This window provides similar functionality to the Calculations Window (see section 
earlier in this chapter) modified to reflect the needs for monitoring the acoustic operations. 

To view, click the View item and select Calculations. 

To configure, select the vehicle from the dropdown list of vehicles (this list contains only 
those vehicles with acoustic data types attached to them). Then click the Setup button to 
access the configuration dialog. 
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Only acoustic related data types are listed. The presentation options are Data Item Text and LOP. 

To enable the display of a data type for viewing, select the desired data type and click the 
On button. To disable, repeat this process but click the Off button. 

Then select one or both display options and click OK. 

The following figure is an example of an LBL TRANSCEIVER data type using the Data 
Item Text option. 

 

The following figure is an example of an LBL TRANSCEIVER data type using the LOP 
option. 

 

For more details on the windows presented, refer to the LBL Operations and USBL 
Operations chapters. 
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Time Series 
This window provides a time series view of the data associated with the acoustic data types. 

To view, click the View item and select Time Series. Immediately, the configuration dialog 
pops up. 

 

All data types available for viewing using the time series window are listed in the list box. 
They are given by vehicle name, device type, device name and data type name. Select one 
and click the On button. If you wish to view more than one, select another and click the On 
button again. Note that the window will become cluttered and difficult to interpret if too 
many data types are displayed. Click OK to exit this dialog and view the time series window. 

 

The window provides a comprehensive time series display of the pertinent data and includes 
a legend and button control for changing the viewing window. 

The left and right arrows in the tool bar control the length of the time series. The +/- buttons on 
the right side of the window control the respective top and bottom limits of the time series. 

Clicking the Clock button in the tool bar toggles between freezing and unfreezing the time 
series plot. 
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Clicking the Printer button in the tool bar generates a printout of the time series window. 
When this is clicked, you are prompted for a heading for the printout. 

 

This is followed by the typical Windows printer setup dialog box.  

To configure the individual data plot lines, double click on the respective data in the legend 
to access the configuration dialog. 

 

From this dialog, the line color and width can be selected. The plot for the respective data 
can also be enabled or disabled by checking or un-checking the Active checkbox. In 
addition, the background can be toggled between gray and white by checking or un-
checking the Gray Background checkbox. 

To reconfigure the data type selected for display, go to View and select Time Series. The 
configuration dialog pops up. Re-configure as required. 
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Extended Status 
This window provides a view of the extended status of Sonardyne transponders. 

To view, click the View item and select Extended Status. 

 

A dropdown list box at the top left of the window presents a list of the transponders 
available for viewing in this window. When selected, the extended status information is 
displayed in the appropriate read only boxes. 

For details on the information presented in this window, see Working Xponders in the 
Working Files chapter. 
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Anchor Handling Window 
The Anchor Handling window displays navigation and anchor handling data for use in anchor 
placement tasks. This window generically refers to the vehicle that is attached to the anchors as 
a “Barge.” It allows you to monitor and record all anchor handling operations including picking 
up anchors off of a Barge, navigating toward a defined Target location, and dropping the 
anchor’s On-Bottom coordinates. The Barge vehicle, Tug vehicles, and Anchors can be 
selected from dropdown menus in the Anchor Handling window. It is also possible to view 
multiple Anchor Handling windows, if required. 

The Anchor Handling window has two sections. The top, or Barge, section supports the 
selection and manipulation of those vehicles configured as Barges. The bottom, or Anchor 
Vehicle, section supports the selection and manipulation of those vehicles designated as anchor 
vehicles. The window can be configured to display from 1 to 5 anchor vehicles (default is 3). 

The Anchor Handling window can be re-sized and the font used to display the anchor vehicle 
information is scaled with the window size. This feature, combined with the option to specify 
how many anchor vehicles to display, enables the manipulation of the window for optimum 
viewing at a distance. 

You must configure the Barge vehicle and its Anchors before this window can be used. Any 
WinFrog vehicle that has been configured as Fairlead Possible is considered to be a Barge. 
Onboard anchor positions (i.e. Fairlead positions) are configured under the vehicle’s Fairlead 
option. Fairleads are defined as the physical location on the barge where the anchor lines lead 
to the Anchors. 

To Configure a Vehicle as a Barge Vehicle 
1 Select the main menu item Configure > Vehicles. 

2 Highlight the barge vehicle (i.e. the vehicle that has the anchors onboard) and select the 
Vehicle Presentation option. 

3 In the Anchor Fairleads category, select Possible then click OK to return to the Configure 
Vehicles dialog box. 

4 Now, with the same vehicle name still highlighted, select the Setup Fairleads/Anchors 
option.  

The Fairleads dialog box is used to configure up to 16 Fairleads (i.e. the onboard 
positions of up to 16 anchors), as seen in the next figure. 

8-74  WinFrog User’s Guide – Operator Display Windows 



 

5 Enter a Name and the Offsets, as measured from the vehicle’s CRP, for each anchor. 

6 Check the On box to enable plotting of that anchor on the Graphics screen. 

Note: do not enter any values into the Northing, Easting, or Status windows. These windows 
will update as the anchors are picked up by other vehicles or as they are dropped on the bottom. 

Select the appropriate Edit button at the bottom of the Fairlead dialog box to change the colors 
of the Fairleads in the Graphics screen. The Static Color is for when the anchor is not being 
handled (i.e. onboard the barge or on the bottom). The Active Color is used when the anchor 
has been picked up. 

Once all Fairleads are configured as desired, select OK to close the Fairleads window and 
return to the Configure Vehicle window. 
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To Display and Configure the Anchor Handling Window 
1 Choose the main menu item View > Anchor Handling. 

 

Top Area - Barge Vehicle Buttons 

Barge dropdown lists all of the vehicles that have been configured 
as Anchor Fairleads Possible. Typically, only 
one vehicle should be designated Fairleads 
Possible. 

Anchor dropdown lists all anchors that have been configured on the 
vehicle selected in the Barge menu above 
(Configure > Vehicles > Fairleads). 

Color box shows the color of the selected barge vehicle.  
Print button prints a summary of anchor locations; can be 

directed to the printer and/or an .rtf file. 
Pick button changes the selected Anchor Status to On 

Board the selected barge vehicle at its 
configured fairlead location (i.e. the barge picks 
up the anchor). 

Drop button changes the selected Anchor Status to On 
Bottom and updates the Anchor Target 
position to the anchor’s current position (i.e. the 
anchor has been dropped to the bottom directly 
from the barge, rather than being first handled 
by a Tug vehicle). 

Target button When selected, causes a blue square, labeled as 
per the selected anchor, to appear at the drop 
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target coordinates. To remove the blue target 
square from the Graphics screen, choose the 
appropriate anchor and select Target again. 

Reset button Opens the Reset Anchor on Bottom dialog box 
to allow you to relocate the anchor on the 
bottom, if it has moved. The position that shows 
in the Reset Anchor on Bottom dialog box is 
the last known bottom position for the anchor. 
Enter a new position as desired. 

 
Edit button Select this button to open the Anchor dialog 

box, as seen below. This window allows you to 
edit the selected anchor’s (i.e. Fairlead’s) 
previously entered Name and onboard Location 
and also define a Target position. 
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Anchor dialog box 
Plot checkbox  Select this option to enable plotting of this 

anchor in the Graphics display. 

Name 
Entry field Highlight this window and change the Name of 

the selected anchor as required. 

Fairlead 
Fore/Aft and Port/Stbd Highlight the Fore/Aft or Port/Stbd entry field 

and change the previously configured 
Anchor/Fairlead location. 

Anchor to MidBuoy 
Entry fields MidBuoys are buoys placed along an anchor 

cable to lift the cable off of the bottom. 
Midbuoys are used when the anchor line is 
knowingly placed across an existing pipeline or 
cable to prevent damage to the existing 
structure. Highlight the appropriate window and 
enter the desired Anchor to Fairlead distance. 

Target Location 
Position and Range/Bearing You can enter anchor Target Location 

information as either a Position (grid or 
geographical coordinates) or as a Range/Bearing 
relative to the barge’s location and heading. 

 If Position is selected, you can enter the 
coordinates manually or click the Copy button 
to copy the coordinates from WinFrog’s 
temporary clipboard memory. (For example, if 
you click on the Graphics screen with the 
Display Position option enabled, the 
coordinates are written to the “clipboard.”) 

 If Range/Bearing is selected, you must enter a 
Range (distance) from the (onboard) fairlead 
position and the angle from the Vehicle’s Bow. 
Note: this is a relative angle measured 
clockwise from the vehicle’s bow, not an 
absolute bearing from North. 

 Note: if the target position is altered with the 
anchor on the bottom, the anchor’s position is 
overwritten by the new target position. Any 
changes made within this dialog box are entered 
directly into the Fairleads dialog box. (See the 
To Configure Fairleads and Anchors section 
of the Vehicles chapter.) 
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Bottom Areas - Anchor Handling Vehicles 
The areas repeated immediately below the barge vehicle buttons are for the display of 
Anchor Handling Vehicle (i.e. “tugs”) data. The buttons and dropdown menus are repeated 
in each area so that the specified number of vehicles/anchors can be tracked and viewed at 
the same time. 

If required, multiple Anchor Handling windows can be opened and configured accordingly 
in order to view all anchor vehicles. 

Upper Untitled dropdown lists all of the Anchor Handling Vehicles (“Tugs”)- 
i.e. those vehicles that have been configured Not 
Anchor Fairleads Possible. (Configure > Vehicles 
> Vehicle Presentation). 

Lower Untitled dropdown lists all of the anchors (fairleads) that have been 
configured on the barge vehicle. 

Color box shows the color of the selected Anchor 
Handling Vehicle (i.e. Tug). 

Pick button Click this button to tell WinFrog that this 
vehicle has picked up the anchor displayed just 
below. (It will be picked up at the Tracked 
Offset on this vehicle). This results in several 
changes: 

 The On: line, just below, will indicate that the 
anchor is now on this vehicle. 

 The Graphics display will draw a line from the 
original onboard (barge) location to the (tug) 
vehicle’s present location. WinFrog changes the 
selected anchor Status to On Board the selected 
anchor handling vehicle at its tracked offset. 
This also generates an event that is written to the 
Working Logs (.LOG) file and output to the 
printer. See the Eventing chapter for more 
details on the Working Logs file. 

Drop button changes the selected anchor’s Status to On 
Bottom and updates the anchor’s Target 
position to the anchor’s current position and 
turns off the anchor run line drawing and 
tracking. This also generates an event that is 
written to the Working Logs file and output to 
the printer. 

Tx button  opens the Tug Target Position dialog box to 
enable you to transmit the Target position to a 
Tug Vehicle and to draw and track an Anchor 
Run Line (see section below). This obviously 
requires a telemetry system to be in place and 
operational. 
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On: displays the anchor state, i.e. whether it is on a 
vehicle or On Bottom. 

OUT: displays the distance and bearing from the 
fairlead location on the barge to its present 
location. 

TOGO: displays the distance and bearing from the 
present anchor location to its target location. 

VES: displays the tug’s present speed and heading. 
Again, this requires telemetry hardware to be in 
place to provide the barge with the tug’s 
positioning information. 

Anchor Events 
When the Pick and Drop buttons are clicked, WinFrog generates an event. This event is 
automatically logged to the current Manual Log file. In addition, the event can be printed to the 
printer. You can control whether or not the events are printed in real-time. The default when a 
window is opened is to print the events. This setting is saved to and loaded from the .ini and .cfg 
files. 

To Configure the Anchor Event Printing 
1 Move the cursor to a point in the Anchor window where it is not over one of the buttons or 

data entry fields and then right-click. 

2 The first option in the resulting pop-up menu is Print Event. Click this item to toggle the 
setting on and off. If it is on, the item is listed with a check mark beside it. 

Anchor Run Lines 
The Draw Run Line checkbox in the Tug Target Position dialog box allows you to draw and 
track run lines between the fairlead and the target anchor positions.  

This option allows you to display locally and transmit to controlled and smart remotes, a run 
line from the fairleads to the target anchor positions. Because multiple anchors may be ran at 
the same time, the users at the master and at the smart remotes (i.e., winch operators) may want 
to view run lines for more than one Fairlead/Anchor. The users at the controlled remotes would 
likely only be concerned about the run line for their particular anchor.  
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The anchor run lines are survey lines and set as the tracked line for the corresponding vehicle in 
the Graphics windows, and as line data in the Vehicle Text window.  

The checkbox allows you to turn on/off the drawing of the anchor run line at the corresponding 
controlled remote. Only the run line pertaining to the specified tug should be drawn at the 
corresponding controlled remote. When the run line is drawn the run line tracking is on, and 
when the drawing turns off the run line tracking is off too. 

The Drop button in Bottom Area – Anchor Handling Vehicles changes the selected anchor’s 
Status to On Bottom and turns off the anchor run line drawing and tracking. 

Note: When using the anchor run line feature with a Controlled Remote, it is possible that if the 
communication link with the Remote is lost after the run line is transmitted, and the 
anchor is picked and/or dropped before the link is re-established, the line tracking in the 
Vehicle Text window and the run line in the Graphics window will not be removed when 
pick and drop are subsequently performed. To remedy this, either re-send the run line (or 
send another one) after the link is re-established, or turn off line tracking for the Remote 
vehicle by accessing the Setup Line Tracking dialog from the Vehicle Text window. 

Anchor Handling Window Configuration 

To Configure the Number of Anchor Vehicles to Display 
1 Move the cursor to a point in the Anchor window where it is not over one of the buttons or 

data entry fields and then right-click. 

2 The pop-up menu lists Display n Anchor Vehicle where n is 1 to 5. The current setting is 
indicated with a check mark. Select the item that corresponds to the desired number of 
anchor vehicles to display in the window. 

Anchor Information Window 
The Anchor Information window displays status information of each of the anchors/fairleads 
setup in the Anchor Handling window. This window generically refers to the vehicle that is 
attached to the anchors as a “Barge.” It allows you to monitor the status of each anchor during 
anchor operations. The coordinates are only displayed when the anchor is on bottom. The 
distance and azimuth is from the fairlead to the anchor; these are 0 if the anchor is on the barge. 

Printing can be to a file and/or to the Windows default printer. 

See the Anchor Handling section for details on anchor operations. 
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Alarms Window 
WinFrog’s Alarm feature provides you with the ability to configure alarms to respond to almost 
any real-time condition. The Alarms window displays the real-time (instantaneous) conditions 
of the various alarms with the use of standard “status colors”; green indicating a good status, 
yellow for caution, and red for full alarm. Note: the Alarm window remains blank until you 
configure the required alarms. This section details both the configuration and display of alarms. 

To Display the Alarms Window 
1 From the View menu, choose Alarms. 

An empty Alarms window displays. The Alarm window can be changed in size or moved 
by “grabbing” the display window edges (or title bar) with the mouse pointer and moving it 
as desired. 

To Configure Alarms 
1 Select the main menu item Configure > Alarms. 

An empty Configure Alarms window appears, as seen below. 

 

2 Click on the Add button to bring up the Alarm Setup window, as seen below. 
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Click on the “+” symbol beside a Device or Vehicle Name to expand the list of items that 
can be added to the Alarm list. All items which can be selected for a particular Vehicle or 
Device are listed in the Available Numerics portion of the Alarm Setup window. 

NOTE: In the case of a device, if it supports multiple instances of the same data type, these 
are displayed with a common name followed by a counter digit. This counter starts at 0. For 
example, a USBL device generally supports tracking of up to 10 beacons. When the USBL 
device is expanded, the ten possible beacons are listed as Bcn. n where the n increments 
from 0 to 9. The counter does not reflect the beacon code, but the index of that beacon with 
respect to the device. 

3a Double-click on the desired item in the Available Numerics window to select it and have it 
displayed in the Selected Numeric portion of the window. 

Or 

3b Highlight the desired item and click on the Select button.  

In the display seen below, the GGA Position HDOP value has been selected. 

 

4 Type in a description for the device in the Description entry window. 
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5 Select the appropriate condition from the Condition dropdown box.  

Note: ensure that the correct units are being used for the alarm. Select the Units button in 
the bottom of the Selected Numeric portion of the Alarm Setup window to change units as 
required. 

6 Enter the appropriate Red Alert and Yellow Alert values. 

7 Enable the Yellow Alert (optional). 

8 Enable the Sound Alert and choose the desired option from the dropdown menu (optional). 

9 Repeat steps 3 through 8 to configure additional alarms. Select OK to return to the 
Configure Alarms window once all desired alarms are added. 

10 Select the Edit... button to change a configured alarm, if required. 

11 Select Close from the Configure Alarms dialog box to close the window and save the 
changes. 

The Alarms display window now shows the configured alarms and the current status of 
each. 

Attitude Window 
The Attitude window graphically displays a variety of navigation information relating to the 
current vehicle. (The current vehicle is the one that is displayed in the Vehicle Text window). 
The information displayed in the Attitude window can also be simultaneously displayed in text 
form in the Vehicle Text window. However, in time critical operations, the information can be 
seen much easier and quicker using the Attitude window. 

Note: only one Attitude window can be displayed at a time and the window size is not 
configurable. 

To Display the Attitude Window 
1 From the View menu, choose Attitude. 

 

The following information is found in the Attitude window, clockwise from the top. 
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BRG displays (in red) the bearing of the survey line 
segment currently being tracked by the current 
vehicle. If a survey line is not being tracked, 
BRG represents the bearing to a tracked 
waypoint. If neither are being tracked, BRG will 
show the last BRG value used. 

 The BRG value is also graphically represented 
in red on the “compass” in the center of the 
display. 

HDG displays (in green) the heading of the current 
vehicle. The HDG value is also graphically 
represented in green on the “compass” in the 
center of the display. 

CMG displays (in blue) the Course Made Good of the 
current vehicle. The CMG is the inverse 
bearing between the last two filtered positions. 
The CMG is also graphically represented in 
blue on the “compass” in the center of the 
display. 

SPD On the left side of the Attitude window is the 
Speed (SPD) Indicator bar. As the current 
vehicle’s speed increases, the blue bar will grow 
to reflect the increase in speed, ranging from 0 
to 10 knots. 

Slide bar Along the bottom of the Attitude window, the 
blue Cross Track Error Indicator bar moves 
from side to side as the vehicle crosses the 
currently tracked survey line segment. If the 
vehicle is to the Port of the currently tracked 
survey line segment, the “tab” is to the left of 
center. 

 The numbers in this section of the Attitude 
window also indicate whether the vehicle is to 
the left or right of the currently tracked survey 
line segment. A negative offset value means the 
vehicle is to the Port of the line segment (in 
terms of the direction that the line coordinates 
were entered and the direction that the line is 
being tracked). 

 Use the adjustable bar at the bottom of the 
window to change the Scale of the Cross Track 
Indicator. The value shown in the bottom left 
corner is one half of the entire width of the 
Cross Track Indicator. 
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Auditor Window 
WinFrog’s Auditor Window allows you to keep track of all significant operations that have 
occurred in the current WinFrog session. Note: the term “significant operations” is used to refer 
only to those items that have some affect on the overall configuration of the program. These are 
noted in the Auditor display. For example, operations such as enabling or disabling displays, 
zooming in or out, or enabling or disabling waypoint or survey line tracking are not considered 
significant and are not noted in the Auditor display window. 

Items that are included in the Auditor window include any changes to the Working Geodetics, 
Working Files, or Working Units. 

To Display the Auditor Window 
1 From the View menu, choose Auditor. 

An empty Auditor window appears. The Auditor window can be changed in size or moved 
to a new location by “grabbing” the display window edges (or title bar) with the mouse 
pointer and moving the mouse as desired. 

If the Auditor window was enabled when WinFrog was last shutdown, you can simply re-
open it rather than display a new window. 

To Re-Open the Auditor Window 
1 Select the main menu item Window, then select Auditor. 

The Auditor window will now appear in the size and location that it was last configured, 
with the significant items displayed, as per the example seen below. 
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Bird’s Eye Window 
The Bird’s Eye window provides all of the same display options and functionality available in 
the Graphics display. In addition to these features, the Bird’s Eye display also plots a “box” 
that depicts the location and limits of the Graphics window. This box always remains correct in 
scale, even as the Bird’s Eye and Graphics display scales are changed. Although WinFrog can 
display several Graphics windows, only one Bird’s Eye window can be displayed. The Bird’s 
Eye window is configured in the same way as the Graphics window. 

To Display the Bird’s Eye Window 
1 From the View menu, choose Bird’s Eye. 

By default, the Bird’s Eye display is located in the lower left corner of the WinFrog display 
space. The location and size of the Bird’s Eye display can be changed by simply clicking 
and dragging the edges of the display box. 

 

A white box is drawn on the Bird’s Eye window to represent the area currently displayed in 
the related Graphics window. Note: the white box may not be visible if the Bird’s Eye 
window is zoomed in very close or is centered on a different point from the Graphics 
window. 

To Configure the Bird’s Eye Window 
1a With the Bird’s Eye window selected, choose the main menu item Configure > Bird’s 

Eye. 

Or 

WinFrog User’s Guide – Operator Display Windows  8-87 



1b Move the mouse pointer into the Bird’s Eye display box limits, right-click and select the 
Configure option. 

The display parameters that can be configured for the Bird’s Eye window are identical to, 
but independent of, those for the Graphics window. This allows you to display the same (or 
different) information as the Graphics window. 

Refer to the Configure Graphics window section earlier in this chapter for information 
describing the various configuration options for the Bird’s Eye window. 

Calculations Window 
The Calculations window displays real-time Data, Statistics, and Quality Control information 
for any device that has been added to a WinFrog vehicle. Several Calculations windows can be 
displayed at once, giving you the capability to simultaneously display information for several 
vehicles and devices. 

Note: each Calculations Window can display data for any number of devices, but for 
organizational purposes it is recommended that you open a new Calculations window for each 
device. 

To Display a Calculations Window 
1 From the View menu, choose Calculations. 

 

To Configure the Calculations Window 
1 If there is more than one Calculations window currently displayed, click the title bar of the 

one to be configured to make it the active window. 

2 Select the appropriate vehicle from the dropdown menu list. 

3 Click the Setup button to bring up the Setup Calculation Views window, as seen in the 
next figure. 
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All of the devices that have been added to that vehicle’s position are displayed in the white 
window area. 

4 Choose the device for which you wish to see data displayed. 

5 Click the On button. 

6 Check the desired box in the Included Views area at the top of the Setup Calculation 
Views dialog box. Each of these options will enable a different data display in the 
Calculations window, as defined below. 

Position box Displays Position data in the top of the 
Calculations window, as seen below. (This 
option is the only one that does not require any 
devices to be turned on in the Calculations 
window as described in Steps 3 and 4 above). 

 

The selected vehicle’s current Latitude, Longitude, Elevation, Heading, and 
Water Depth are updated every program cycle. 

AGE box displays the age of the WinFrog position. 
STAT button is a visual cue that indicates the status of the 

filtered position. A green cue indicates the 
position is good, a yellow cue indicates the 
position is degraded (the position 
calculation has failed for more than 15 
seconds), and a red cue indicates the 
position is invalid (the position calculation 
has failed for more than 30 seconds). If the 
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cue turns red, an alarm sounds, which can be 
silenced by clicking the ACK button. 

ACK button used to silence the status alarm 
Position button (located below the Elev. information) 
 This button is a shortcut to the selected 

vehicle’s Configure Vehicle-Devices 
window. This provides you quick access to 
edit any devices that have been added to the 
vehicle’s position calculations. 

Data Item Text box Select this option to display the latest data from 
all devices that have been turned On in the 
Setup Calculation Views dialog box. Typically, 
this option is just used to display information for 
GPS device(s), particularly for GPS 
Pseudorange Calculations and Multi-Ref 
solution data. 

 Three buttons are displayed in a device’s Data 
Item Text window, directly above the device 
information, four if the selected data item 
supports the fix print option. The functions of 
each button from the left are as follows: 

 The first button provides a shortcut to the 
configuration menu for that particular device, as 
used by that vehicle. 

 The second button is not used. 
 The third button is used to toggle through 

different information pages for that device, if 
available. 

 The fourth button prints a fix report for the 
epoch displayed when the button is clicked. You 
are then prompted for print options – print 
directly to the printer and/or print to an rtf file. 

 If the data item being displayed also supports the 
Data Item Averaging option, there are additional 
buttons associated with this feature to the right 
of the print button. See Data Item Averaging 
below. 

Position Comparison box Select this option to display the coordinates of 
all Primary and Secondary positioning devices 
as well as real-time comparisons between their 
positions. Survey Line and Waypoint tracking 
data averaged over time can also be displayed. 
This comparison is user-configured and can be 
written to file for subsequent viewing and QC 
analysis. 

Data Item Averaging 
The Data Item Averaging feature provides the means to collect data for a specific data 
item for the purpose of determining a mean over a given number of epochs complete 
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with the respective standard deviations for the sample set. This feature is accessed via 
the Data Item display (see Data Item Text box above). 

Note: Not all data items support this option. If a data item supports this option the 
respective buttons are available in the Data Item window. 

 

The LBL XPONDER data item supports this feature and is shown in the above figure. 

1 Configure the automatic data collection. 

The collection of the data can be done automatically or manually. If it is to be done 
automatically, you can configure parameters for the collection. To configure these, 
click  to access the following dialog. 
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i. If you do not wish to apply any constraints to the data collection, select Do 
not apply Constraints. All data is collected with the exception of that which 
fails the specific data item constraints (e.g. if an LBL adjustment fails). In 
the case of LBL positioning, if the position determination fails, the data is 
not captured even if no constraints are applied via this configuration. 

ii. If you do wish to apply constraints to the data collection, select Apply 
Constraints. If this is selected, the constraint options become available. 

a. Apply maximum RMS. Select this option if only those epochs whose 
solution RMS is less than a specific tolerance are to be collected. Enter 
this tolerance. 

b. Apply maximum Standard Deviation. Select this option if only those 
epochs whose solution standard deviation(s) is less than a specific 
tolerance are to be collected. Enter this tolerance. 

c. Apply minimum LOPs. Select this option if only those epochs that use 
at minimum a specified number of LOPs are to be collected. Enter this 
number. 

d. Apply number of epochs to collect. Select this option if you want 
WinFrog to automatically stop collecting data when a specified number 
of epochs are collected. Enter this number. 

iii. Click OK to apply the constraints. Note that this configuration is saved to the 
INI and CFG files for the respective data item. If the Calculation Window is 
closed and then re-opened and the data item is re-selected for display, the 
previous configuration is still present. 

2 Clear the data from memory. 

Once data has been collected (or loaded from a file) WinFrog maintains it in 
memory. If you wish to start a new data item averaging session, you will need to 
clear the data from memory. To do this, click the  button. 

3 Start the data collection. 
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To start automatic data collection, click the  button. The data collection process 
will immediately start, starting with the current epoch, which is checked and saved if 
it meets the constraints or regardless if the constraints are not being applied. The 
button will change to . 

4 Stop the data collection. 

To stop the automatic data collection, click the  button. The data collection 
process will immediately stop and the button will change to . 

5 To manually capture data. 

A data epoch can be captured at any time, even if the data logging is active and the 
current epoch was rejected due to the data item averaging data collection constraints. 
To capture the current epoch without consideration of the data collection constraints, 
click the  button. 

6 To process the data. 

To review the data currently in memory or load data from a file, click the  button. 
Note that this button is only active when the automatic data collection is not. 
Clicking this button presents the respective processing dialog. The following is the 
dialog for the LBL acoustic data items XPONDER and LBL TRANSCEIVER. 
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i. View the results 

The mean position and depth along with the mean True and Grid heading 
for the vehicle are displayed in the Sample Results panel, with the 
respective standard deviations for the sample set. The position can be 
viewed in geographic or map projection grid by selecting the appropriate 
Geo or Grid radio button. The position and depth display defaults to the 
respective sensor. The associated CRP position and depth can be displayed 
by clicking the Display CRP button and back to the sensor by clicking the 
Display Sensor button. Note that the CRP position is derived from the 
sensor data and is not the filtered vehicle CRP position. 

The size of the sample and the number of the set that are used for the mean 
determinations is also shown. 

ii. Enter a comment 

A comment to be associated with this data set can be entered in the 
Comment field. It is printed and saved/loaded to/from the data file. If one is 
already present for the respective data set, it is displayed and available for 
editing. 

iii. View the epoch summary. 
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The summary of data epochs captured is displayed in the Observed data list 
window. 

iv. Toggle an epoch to be used or not used 

All data captured defaults to be used. To toggle any epoch’s current setting, 
double-click the epoch number field. Upon a change in any epoch’s 
use/don’t use setting, the mean is re-determined and displayed. 

v. View an epoch 

To view the data for any epoch, click on the desired epoch’s number and 
click the View button. The data is presented as it would be in the Calculation 
Window, Data Item view, with some exceptions. 

• Age information is not shown. Instead the associated time is shown. 

• The button used in the Calculation Window to toggle between different 
presentations of the data is replaced with a Page button. 

• The use status of the data in the determination is displayed and can be 
toggled by clicking the Toggle On/Off button. 

vi. Save the data 

To save data currently in memory, click the Save button, navigate to the 
appropriate location and select or enter a file name to save to. 

vii. Load data 

To load data into memory, click the Load button, navigate to the appropriate 
location and select a file to load. When data is loaded, any data currently in 
memory is lost. 

Note: If you load data into memory, you can append to it simply by re-
starting the data collection or clicking the manual data collection button. To 
do this, make sure you leave this dialog by clicking OK after loading data. 

Note: You can only load data for the same data item type as the data item 
window is set for. 

viii. Scatter Plot 

The panel in the top right of the dialog presents a scatter plot of the sensor 
position data. 

ix. Print data 

To print the results of the mean data determination, click the Report button 
and select to print to the printer or file using RTF format. The print out 
provides a summary of the data collection, the results for both the sensor and 
CRP positions complete with the respective sample set standard deviations 
and the comment. Each individual epoch is also printed. 

7 Monitor data item averaging 
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The status of the data item averaging is displayed at the bottom of the respective data 
item window.  

 

There are several states: 

Disabled Automatic data collection is off and there is no data in 
memory. 

Active    Count: n Automatic data collection is enabled, n is the number of 
epochs currently in memory. 

Paused   Count: n  Automatic data collection is off but there is data in 
memory, n is the number of epochs currently in memory. 

Completed Automatic data collection was active with the number of 
epochs to collect option active. This number has been 
reached. 

 

To Perform a Position Comparison 
1 Select the Position Comparison checkbox in the Setup Calculation Views dialog. 

2 Turn On the Primary and Secondary devices. 

3 Select OK to return to the Calculations window. 

4 Select the Edit button. 

 

There are two Position Comparison options available: Normal and MultiRef.  

Normal displays the comparison information between 
the Primary and Secondary positioning 
devices. 

MultiRef displays the comparison information between 
the weighted mean multi-reference position and 
the individual (single reference station) 
solutions. 

An Averaging Time must be entered for either of these options. 
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5 Choose Normal or MultiRef and enter and Averaging Time. 

When you return to the Calculations window, your Averaging Time input displays as 
Time Remaining and counts down to zero. The comparison, which will automatically 
repeat itself, can also be manually controlled by using the Start and Stop buttons. These 
data are not recorded to any files. 

Position Comparison Display 
The first line of the Position Comparison section of the Calculations window lists the 
Primary Positioning Device with its user-assigned name. 

The second line displays that device’s position in grid Northing and Easting. 

The third and fourth lines display the same information for the Secondary Positioning 
Device. 

The fifth line displays the instantaneous differences in the Northings and Eastings between 
the two devices. 

Below that information is the Average Position Comparison. By default, the average is 
based on a one-minute time period. If there is another Secondary positioning device, the 
same information appears for it as it does for the first secondary. The bottom line displays 
the time remaining (in minutes) for the Comparison Average. 

Position Comp. Histogram Select this option to enable a Calculations 
window display that plots a real-time histogram 
of the Position Comparison between the 
Primary and Secondary Positioning devices. 
Note: this window does not require any devices 
to be turned On in the Calculation window’s 
Config option. 
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To Configure a Position Comparison Histogram 

1 Click and move the sliding bar above the display window to set the Center of the Plot. 
(This is the absolute value of combined Northing and Easting errors). 

2 Click on the radio buttons on the left of the display window to set the overall Height of the 
display to see changes in data more clearly 

3 Select and slide the bar at the bottom left corner of the window to set the Number of Bins 
that are displayed. 

4 Select and slide the bar at the bottom right corner to set the Horizontal Panel Width 
(range) of the window. 

Note: the Center value will change as you change the Width value at the bottom of the 
screen. This may cause your data to “disappear” from the display window, requiring you to 
re-center the data to a realistic value. 

Time Series  Select this option to display a graphical 
representation of a device’s Data relative to 
Time. This can be used to view how the 
position, water depth, etc. change over time. 

 The data displayed in the Time Series graph are 
for the selected device, set to On. Only one data 
item can be graphed in each window at a time, 
but you can simultaneously display multiple 
Time Series windows in the same Calculations 
display. A new window will be created for each 
device turned On in the Calculations window 
Setup. This window is typically used for the 
display of sounder depth data. 

 

To Configure the Time Series Graph 
1 Select the adjustment arrows on the right side of the time series window to change the Top 

and Bottom limits of the data display (in the same units as the device data). 
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This is used to set both the vertical scale of the display as well as the center of the data.  

2 Select the adjustment arrows found at the bottom of the display window to set the time 
range (i.e. the horizontal scale) of the plot in seconds. 

LOP  This Setup Calculations Views window option 
is used to display “Lines of Position”. This term 
is derived from the time when shore-based 
ranging systems were the primary method of 
vehicle positioning, before GPS. The term “Line 
of Position” refers to a range used in the position 
determination. The LOP display in the 
Calculation window can be used to display 
“ranges” from range/range, LBL acoustic, and 
GPS pseudorange devices. The example below 
shows the ranges from GPS satellites used in the 
pseudorange solution. 

 

 The azimuth and elevation of the GPS satellites 
used in the pseudorange solution are displayed 
too. 

Heading Comparison  This Setup Calculations View window option 
is used to present a comparison of the data from 
a vehicle’s Primary and Secondary heading 
devices, as seen in the next figure. 
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Pos. Comp. Time Series  This option is used to present a graphical time 
series comparison of the data from a vehicle’s 
Primary and Secondary positioning devices, as 
seen in the next figure. 

 

Use the Up and Down arrows on the right side of the window to change the center value 
and the width of the display window. Click on the left “page” icon to access the Configure 
Time Series Plot dialog window, as seen below. 

 

Use the Configure Time Series Plot dialog window to configure Automatic or Manual 
control of the Vertical (distance) Axis mid-point and the total range of the vertical data 
displayed. 

Controlled Remote Window 
WinFrog’s Controlled Remote window allows you to configure a ”remote” WinFrog system 
and display real-time data for that vehicle. A remote WinFrog system is a WinFrog system 
connected to another WinFrog system via a token ring telemetry network. See the Controlled 
Remote Tug Telemetry chapter for complete details on the use of the Controlled Remote 
window. 
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Distance Counter Window 
WinFrog’s Distance Counter feature is used for calculating and displaying an incremental 
counter of the distance between a selected Offset point on a vehicle from a specified starting 
location. The initial value of the counter can be set to an arbitrary value and can be set to 
increase or decrease as the vessel moves to or from the start. 

To Display the Distance Counter Window 
1 From the View menu, choose Distance Counter. 

 

Vehicle Selection Select the vehicle from the drop down list that you 
wish to use with the counter. 

Counter Setup 
Increase Causes the counter value to increase as the vessel 

moves away from the initial position, or decrease 
as it moves towards the position. 

Decrease Causes the counter value to decrease as the vessel 
moves away from the initial position, or increase 
as it moves towards the position. 

Initial Value Enter the desired initial value of the counter at the 
start position. The counter will start to increment 
or decrement from this value. 

Reset Click this button for any changes you have made to 
take effect. No changes are made to the counter 
settings until this button is clicked. 

Counter Value The counter value is displayed in the top right 
corner of the window. The counter displays the 
grid distance in the current distance units between 
the selected start location and the current location 
of the vehicle or specified offset. 

Start Location At the bottom right corner of the window is the 
start location where the counter started to 
increment/decrement. The start location is selected 
whenever the Reset button is clicked. 
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Note also that the font, size and color of the counter and start position can be changed by right-
clicking on the window to display the font popup menu. Select either Change Counter Font or 
Change Start Position Font to open a standard font selection dialog. 

When the window is closed but WinFrog is not shut down, all settings for the initial counter 
value, direction and start location are lost and need to be reset when the window is opened 
again. 

Dynamic Tracking Window 
WinFrog’s Dynamic Tracking feature is used for calculating and displaying the positional 
difference from a Tracking Offset point on one vehicle to a Tracking Offset point on another 
vehicle. The positional difference can be displayed in four different formats: 

1 Range, Bearing, and Difference in Depth 

2 Difference X, Y, and Z 

3 Difference North, East, and Depth 

4 Range, Relative Bearing and Difference in Depth 

Each combination of Tracking Offsets is referred to as a Track Pair. The Dynamic Tracking 
window displays the positional differences of up to three Track Pairs. Track Pairs are 
configured using the main menu item Configure > Vehicles > Setup Dynamic Tracking. This 
option displays the Setup Dynamic Tracking dialog box. For more details about configuring 
Track Pairs, see the Dynamic Tracking section in the Vehicles chapter. 

To Display the Dynamic Tracking Window 
1 From the View menu, choose Dynamic Tracking. 

The Dynamic Tracking window displays information 
for a maximum of three different enabled Track Pairs. 
For more details about using this window, see the To 
View the Dynamic Tracking Information section in 
the Vehicles chapter. 
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GPS QA/QC 
The GPS QA/QC display will display GPS quality data for a particular vehicle. The window has 
six tabs to display the QA/QC data available from a GPS receiver. Right-clicking on the Bar 
Charts tab or Time Series tab will reveal a menu allowing selection of different data that may be 
displayed on that tab. 

To display data in all the tabs available, the GPS receiver needs to send the following NMEA 
telegrams: $--GRS, $--GSA, $--GST, and $--GVS.  

One window may be opened for each vehicle. The data for only one GPS receiver should be 
selected for display. This is controlled by selecting the checkbox on the POSITION data item 
configuration dialog. The device must also be set to Primary for the data to be displayed in the 
window. This checkbox should be unchecked for non-GPS devices that have POSITION data 
items as they will not have the necessary QA/QC data to display in this window. Some devices 
however, may have partial data.  

The displayed units in the window are controlled by the elevation selection in the Configuration 
> Units dialog. 

The coordinates displayed on the Position/QC tab are the current reference point coordinates. 

Helmsman Display 
The Helmsman display shows survey line tracking and navigation information in both 
graphic and text formats, specifically intended for quick reference by the helmsman. Only one 
Helmsman Display can be viewed at a time. 

Note: the size and shape of the Helmsman display can be altered by “grabbing” an edge or 
corner and dragging it “in” our “out” as desired. 

To View the Helmsman Display 
1 From the View menu, choose Helmsman. 

 

The following information is found in the Helmsman display window: 

Steering Bar The top portion of the window graphically 
displays the amount that the vehicle’s currently 
tracked reference point is perpendicularly 
Offtrack from the current Tracked Survey 
Line Segment. The bar will “grow” in size from 
the center to the appropriate side as the vehicle 
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moves further offtrack. The Offtrack distance is 
also displayed numerically in this portion of the 
window. Note: the numerical value is always 
positive, regardless of which side of the line the 
vehicle is on. 

Vessel Name the Name of the current vehicle. 
Vessel Speed the calculated Speed of the vessel. 
Vessel Heading the vessel’s heading (as received from a gyro or 

other interfaced directional device, plus any 
user-configured offset). 

Vessel CMG the vessel’s calculated Course Made Good. 
Line Bearing displays the bearing of the current segment of 

the survey line being tracked. 
Line Name displays the name of the survey line being 

tracked. 
SOL displays the distance to the Start Of Line. 
EOL displays the distance to the End Of Line. 
 

The numbers in the moving bar will change to reflect the distance from the center of the display 
to the edge. Select the main menu item Configure > Units > Distances to change the units 
displayed. 

If no Survey Line is currently being tracked, 0.0 is displayed and no changes will occur in this 
part of the display. 

To Configure the Helmsman Display 
1 Move the mouse pointer to within the limits of the Helmsman display, then press the right 

mouse button. The Configure Helmsman dialog box displays. 

 

Vehicle Name dropdown Choose the appropriate vehicle from the options 
presented in the dropdown box. 
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Max Steering Bar D.O.L. 
dropdown Select from the options presented in the 

dropdown box to change the maximum 
horizontal Distance Off Line (D.O.L.) to be 
depicted in the Steering Bar section of the 
Helmsman display. 

Font Size radio buttons Select the desired Font size. 
2 Adjust the Vehicle Name, the D.O.L., and the Font Size options accordingly. 

3 Click OK. 

Level Bubble Window 
This window displays the pitch and roll of a vehicle using a bull’s eye display. If desired, it can 
also estimate the approximate amount of movement a surface vehicle would need to move, and 
its direction, in order to bring a subsurface vehicle to the level position. This assumes the 
surface vehicle is overtop the subsurface vehicle and is attached by some semi-ridged structure 
such as a drill stem. The vehicles’ CRP elevations are used to determine the vertical distance 
between the vehicles. If there is casing below the bottom vehicle the operator may enter an 
offset to the fulcrum point. 

Up to five Level Bubble windows may be displayed. 

To Display a Level Bubble Window 
1 From the View menu, choose Level Bubble.  
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To Configure the Level Bubble Window 
1 Select the vehicle whose attitude is to be monitored from the top dropdown list box (Veh to 

level). 

2 Using the slider bars, select the number of rings and the total range (1° to 50°) desired. 
Depending upon the number of rings selected, the full range may not be displayed; either 
change the number of rings or the range to display the full range.   

3 The red circle indicates the levelness of the vehicle. The circle may simulate either a bubble 
(air in oil) or a ball (steel in oil). The two radio buttons, Ball and Bubble, determines the 
mode. If Bubble is selected and the vehicle has positive pitch (bow up) the red circle will 
move towards the bow. If in the same situation Ball was selected, the red circle would move 
towards the stern. 

4 The top of the bull’s eye is always considered the bow of the vehicle being leveled. 

5 In the top left corner of the bull’s eye is the total tilt of the vehicle. Below this is either the 
azimuth or bearing relative to the bow of the tilt. The remaining two radio buttons, Relative 
Bearing and Absolute Azimuth, determine which is displayed. If the Relative Bearing is 
chosen, the angle is measured from the bow to the red circle. If the Absolute Azimuth is 
chosen, the angle is measured from true north to the red circle. 

6 Displayed in the lower left of the bull’s eye is the pitch and roll in degrees. Positive pitch is 
bow up; positive roll is starboard down. 

7 If there is a leveling vehicle as described above, select it from the lower dropdown list box 
(Control Veh). 

8 To level the lower vehicle use the display “Move 25 m at 323 degrees” located below the 
slide buttons. The distance to move uses the tilt angle and difference in the CRP elevations; 
the angle is the true azimuth indicating the direction to move the rig. To correct the height 
difference for a section of casing which will act as the pivot point or to correct this 
difference for any other offset, enter a value in the Offset to CRP edit box and click the 
Apply button. This value will be added to the elevation difference and displayed in the 
upper right corner of the bull’s eye. This elevation difference is always considered positive.  

Numerics Display 
The Numerics display provides you the ability to view various user-selected real-time Device 
and Vehicle data items. This display expands on the data presented in the I/O Devices and 
Vehicle Text windows. See the appropriate sections found earlier in this chapter for more 
information on these other windows. 

To View the Numerics Display 
1 From the View menu, choose Numerics.  

A blank Numerics window displays. As with most WinFrog windows, the Numerics 
window can be moved by “grabbing” the top bar of the window and dragging the window 
to the desired location. The window can also be changed in size by “grabbing” any edge of 
the window and “dragging” it as desired. 
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To Configure the Numerics Display 
1 To configure this display, move the mouse pointer to within the limits of the Numerics 

display and click the right mouse button. 

A small dialog box appears offering Setup... and Font Size... options. Select the appropriate 
option. 

Setup 
Select this option to display the Numerics Browser Setup window. 

 

Groups 
This section of the Numerics Browser Setup window divides the available data into two 
source groups: Devices and Vehicles. 

Devices This grouping contains all devices that have 
been added to WinFrog. Click on the “+” 
symbol beside the word “Devices” to see a list 
of these devices. Click on the “+” symbol beside 
a specific device name to see what data are 
available from this device. Select the data name 
to see what numerics are available from this 
data type, listed in the Available Numerics 
window. 

NOTE: If a device supports multiple instances of the same data type, these are displayed 
with a common name followed by a counter digit. This counter starts at 0. For example, a 
USBL device generally supports tracking of up to 10 beacons. When the USBL device is 
expanded, the ten possible beacons are listed as Bcn. n where the n increments from 0 to 9. 
The counter does not reflect the beacon code, but the index of that beacon with respect to 
the device. 

Vehicles The name of each vehicle added to WinFrog will 
be listed in the Groups section. Click on the “+” 
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beside a vehicle name to see what data 
categories are available for that vehicle. Click on 
a data category to see what data items are 
available for each vehicle data category, listed in 
the Available Numerics window. 

Available Numerics 
Available Numerics This section of the Numerics Browser Setup 

window lists all individual Numeric items 
associated with the highlighted “group” data 
item. The example below shows what Available 
Numerics are associated with a NMEA GPS 
device. 

 

Selected Numerics 
This portion of the Numerics Browser Setup dialog box lists the items that have been 
selected from the Available Numerics listing. 

To Add an Item to the Numerics Display 
1 Highlight the Available Numeric item 

2 Click the Add>> button. 

In the example below several items have been added from the Available Numerics for a 
GGA Position. 

8-108  WinFrog User’s Guide – Operator Display Windows 



 

3 Once all desired items have been added, select the OK button to return you to the Numerics 
display, which now reflects the changes just made. 

 

Font Size 
Select this option to display the Font Height window as seen below. Use the dropdown to 
select the desired Font Height. 
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Smart Remote Control 
WinFrog supports the operation of Smart Remotes. A WinFrog system that is not configured 
with real-time inputs and outputs may provide the means to view and monitor the positioning 
and navigation being performed by the primary WinFrog system. A Smart Remote does not 
require a license. A computer running WinFrog in demonstration mode can be operated as a 
Smart Remote. 

To simplify the operation of the Smart Remotes, WinFrog provides the means for you to 
configure the Smart Remotes from the primary WinFrog system, referred to as a master in this 
section. The Smart Remotes will simply be referred to as remotes. 

Network Communications 
WinFrog uses UDP/IP to communicate between the master and remotes. This requires a suitably 
configured Ethernet card to be installed in the computer. When WinFrog is launched, whether 
it’s to be used as a remote or a master, it retrieves the IP address of the computer’s Ethernet 
card. This is used to read/write the required remote navigation information. If at launch, 
WinFrog detects two or more Ethernet cards and none has been directly selected as the card to 
use, a dialog will appear allowing you to choose which card to use. If the computer does not 
have an Ethernet card when WinFrog is launched, or if the Ethernet cable is not connected, 
WinFrog will not be able to retrieve the IP address. In these cases, a message will appear to 
indicate this and instruct you to select, from the main menu, Configure  > Ethernet Card and 
Device Output Control to select the card address when the Ethernet cable has been 
reconnected. In the case of an Ethernet card not being present, the PC will need to be powered 
down, a card installed and WinFrog re-launched. This dialog is also used for the device output 
control which uses the same network as the Smart Remote. See the Peripheral (I/O) Devices 
chapter. 

As previously mentioned, WinFrog uses UDP/IP to send navigation data to the remote computers. 
It uses port 7050 for this. This data is broadcast and can be received by all the suitably configured 
computers on the network. This is determined by the subnet mask entered as part of the TCP/IP 
Properties for the particular card in use. The remote does not respond to this data.  

The master uses port 7060 to send configuration data to the remotes. But first the master sends a 
command on port 7050 to inform the remotes to open and listen on port 7060 for the 
configuration data. This communications involves transmission of configuration data by the 
master and a confirmation of receipt by the selected computers. It should be noted that the 
output of the navigation data on port 7050 is suspended during configuration updates. 

Remote Position Data Reception 
If any vehicle on a given WinFrog system is configured to Network for the Data Source, that 
WinFrog listens for data from a master. The data is transmitted in packets. Each navigation 
packet contains the complete position information for all vehicles in a compressed format. The 
packet that informs a remote that it is to be configured only contains the computer’s name. 
When a remote receives a packet it checks to see if it is a message informing it that a 
configuration update is going to be transmitted (see Remote Configuration) and if so, is it 
intended for this computer (see Master Operation). If a data packet is detected, the vehicle 
names in the packet are compared to those of the vehicles configured to Network for the Data 
Source at the remote. The comparison is case sensitive. If a match is found, the position data is 
assigned to that vehicle. If no match is found, the data is discarded. 
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After the receipt of position data from the master, the remote sets a time out clock.  If new data 
is not received within 15 seconds, a message appears indicating a data time out.  This message 
will not appear again until the reception of another position data packet restarts the timeout 
clock. 

Note: It is critical that the names assigned to the vehicles configured at the remote are identical 
to those used at the master, including case. The use of the remote configuration ensures this.  

Note: It is important to note that the remote will accept position data from any master. There 
should be only one master on the network at one time. If the overall system includes a primary 
and secondary WinFrog, the primary should be used to send the position data to the remotes. If 
it fails, you must turn the data transmission on at the secondary. The remotes do not require a 
configuration update in this case. 

Remote Configuration 
After launching WinFrog on the remote computer, the remote can be configured manually at the 
remote computer or remotely from the master. It is important to note that for the purpose of this 
section, configuration refers to the critical components of WinFrog that are required for the 
successful operation of a Smart Remote, specifically the geodetic and map projection 
parameters; vehicle name, shape and presentation; and though not so critical, the working 
survey lines and waypoint files and the BMM file used for the Graphics windows background 
display. 

For manual configuration refer to the Vehicle Data Source chapter, Network Data Source 
Configuration section. 

To execute the remote configuration, after launching WinFrog first check that the system is 
configured to accept remote configuration. This is done from the main menu item Configure  > 
Smart Remote > Enable Configuration by Master. If the remote is configured to accept 
remote configurations, there will be a checkmark beside this item. Click this item to toggle 
between enabled and disabled. This setting is saved to and loaded from the *.ini and *.cfg files. 
The default setting is enabled for a WinFrog running in demonstration mode, disabled for a 
licensed WinFrog. 

Second, open the desired Graphics, Vehicle Text and Dynamic Tracking windows. The master 
cannot open windows on the remote. Furthermore, if no Graphics windows are open on the remote 
when executing the remote configuration, the BMM map files assigned will not take affect.  

The master sends data in three stages to match the configuration of a remote to itself: 

1) Primary Configuration Components: 

- Geodetic and Map Projection parameters. 

- Display Units. 

- Vehicles including their names, colors, shape (at the remote each 
vehicle is set to Network for the Data Source and defaulted to Network 
for Waypoint, Line and Offset Source). Only vehicles that are 
configured at the master are setup at the remote. Any vehicles present at 
the remote that are not present at the master are removed. 

- All dynamic tracking information. 
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2) Assigns the file name and path for the remote’s Working Survey Line and 
Waypoints Files to those of the master. 

3) Creates copies of the BMM files displayed in the Graphics windows at the 
master and then links the remote Graphics windows to these files.  

When a remote configuration is taking place, a window such as the one below is displayed at 
the remote stating the process being executed. 

 

Note: The remote will accept a configuration update from any master. There should be only one 
master on the network at one time. 

Note: The transmission of the primary configuration components starts with the Geodetics, then 
the units and then the transmission of the list of vehicles to be configured, followed by the 
configuration for each vehicle. The master then waits for the remote to inform it when the 
vehicle updating is completed before continuing. The above figure is the message displayed at 
this time. During this time, the remote will be very slow to respond to operator interaction 
(mouse clicks such as Zoom In). This is normal. 

Note: The smart remote must have access to the Working Survey Line file, the Working 
Waypoint file, and the *.BMM file and all files that are referenced in the BMM file (e.g. DXF, 
DWG, etc.) if it is to use them. This requires that the immediate parent folders in which the files 
are located be shared and that permission be granted to the remote computer’s user to access the 
files. This is most easily accomplished by ensuring that the Master computer has a Guest 
account. For the folders containing the Working Survey Line file and Working Waypoint file, it 
is very strongly recommended that access be limited to Read Only to ensure that the remote 
operator is not able to change them. However, for the folder(s) containing the BMM file and all 
of the referenced files, Write access must be given to the remote in order for WinFrog to 
support the linking of the map files. 

Time synchronization of Smart Remotes 
In addition to position data, a master WinFrog will also broadcast its WinFrog time. Any smart 
remote that is in demo mode (i.e. unlicensed) and has been enabled for Configuration by Master 
will automatically set its WinFrog time to match the master.   

Note: This does not set the actual PC clock time, just the time that WinFrog uses.  

Note: Do not use the time synchronization window at the smart remote. 

Master WinFrog Operation 
The WinFrog that is to operate as the master must be configured to do so. The configuration is 
performed from the Smart Control Window. This window is opened from the main menu item 
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View. The window appears as below, though initially, the computer list window and the status 
message list box are empty.  

 

The following details the window components and button functions. 

Computer List Window The computers that have been added are listed in this 
window. Note that these are the computers that can 
then be selected for remote configuration. The 
addition, selection or removal of computers does not 
affect the transmission of the position data packets. 
Computers can be selected by clicking on the name. 
Multiple computers can be selected by pressing the 
Ctrl key while clicking on the computer name. 

Status Indicates whether or not the computer was detected 
when a configuration update was transmitted to it. 

Vehicles Updated This is the date and time of the last successful update of 
this remote for the primary configuration components. 

Files Updated This is the date and time of the last successful update or 
refresh of this remote for the Working or Map Files. 

Add Computer  Click this button to browse the network and select a 
computer to add to the list of those that can then be 
selected to receive configuration updates. 

Remove Computer  Click this button to remove any computers selected in 
the computer list window. 
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Send Setup Click this button to instigate the transmission of the 
primary configuration components to those computers 
selected in the computer list window. While the 
transmission of the configuration is taking place, this 
button changes to an Abort button. Clicking this cause 
the configuration update to abort. 

Link Working Files  Click this button to instigate the transmission of the 
Working Survey Line and Waypoint File names and paths 
to those computers selected in the computer list window. 

Link Map Files Click this button to instigate the transmission of the file 
names and paths for those BMM files that are 
configured as the backgrounds for those Graphics 
windows open at the master to those computers 
selected in the computer list window. If the respective 
Graphics windows are open at the remote, they will 
display the same layer files as their corresponding 
Graphics window at the master. This includes the 
setting of the Plot Map option in the Graphics window 
configuration Background tab. 

Output is On/Off This button toggles the broadcast of the position data 
on and off. The button text indicates the current status. 
This is not affected by those computers added or 
selected, as it controls the broadcast of the position 
data packets, which are then received by all computers 
on the network. When a configuration update is in 
progress, the output is suspended and this button 
displays Output Is Suspended and is disabled. When 
the configuration is completed, the button and the 
position output mode returns to normal. 

 Note: This output must be turned on in order for 
remotes to operate regardless of whether or not they 
are configured remotely or locally. 

Help  Access the help for Smart Remote configuration and 
operation. 

Configuration Update 
Status Messages The messages detailing what the Smart Remote 

Control is executing are listed in this box. 

With the exception of the Add Computer, Output is On/Off and Help buttons, the buttons are 
only active when there are computers listed in the computer list window and at least one 
computer selected. 

Note: When a configuration is initiated, all the selected computers are set to NOT PRESENT 
in the computer list. WinFrog looks for responses from all selected computers before sending 
the next packet. When a computer responds to confirm that it has received the configuration 
packet, it is set to PRESENT. If after five seconds not all computers have responded, the 
computers that have not responded are removed from the list of those that are expected to 
respond (they will still appear selected in the list) and the next packet is transmitted. If no 
computers respond, the configuration is aborted. 
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The Smart Control Window can be closed without affecting the transmission of the position 
data packets. Unlike most WinFrog windows, the next time it is opened, it will open in the same 
location at the same size it was when it was closed. The computer list is also maintained. 

Note: The Smart Control Window cannot be opened if the computer is currently receiving a 
configuration or refresh command. 

Note: When WinFrog is launched at the master, if the Ethernet cable is not connected, the 
Ethernet card will not be detected. After reconnection of the cable it is necessary to select the card 
from the main menu item Configure > Ethernet Card and Device Output Control. This selects 
the card for port 7050. Then close and open the Smart Remote window for a refresh so the 
configuration port (7060) can be used. Both ports are required for operations at the master. 

Time Synchronization 
WinFrog is able to synchronize to external time sources, typically a GPS receiver, with or 
without a 1PPS (1 pulse per second). The time synchronization is done using the configuration 
dialog box available from the configuration menu. The data may be displayed with the window 
available from the view menu. The window does not have to be present to set up time 
synchronization. 

 

The top portion of the window displays: 

Synchronization displays the On or Off status. 
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Synchronization Type displays the synchronization message or signal configured.. 

Synchronization Device displays the name of the device that the specified message or 
signal is to be obtained from. 

Synchronized at displays the last time and amount of the last adjustment. If time 
synchronization was just started it also displays “Not adjusted, In Spec” or “pending”. 

Current WinFrog  time displays the current WinFrog time. 

WinFrog time at update displays the WinFrog time stamp of the last specified 
message or signal. 

UTC time of update is the time within the last specified message. 

Raw Delta is the time difference between the UTC and WinFrog times of the last 
telegram. This does not include the local time offset. 

Filter Delta is the filtered difference for the last telegram. This does not include the 
local time offset. 

Note: If the specified message or signal has not been received for approximately 10 
seconds, a message alerting you to this will appear. Approximately 2 minutes after a 
message is acknowledged, if the situation has not been corrected another message box 
will appear. In addition, if the Time Synchronization window is open, after the initial 
message and until the situation is corrected, the Synchronization Type line in the 
window will flash black and red with a warning appended. 

The time series panel contains the Raw Delta and Filter Delta values. 

Configuration 
Either right-click on the time synchronization window or select Time Synchronization 
from the Configuration menu to access the following dialog: 
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Synchronize WinFrog Time 
When WinFrog first boots it reads the system clock and from thereafter it applies the system 
tick for a more precise clock. All changes to the WinFrog time just affect this sum and do 
not change the system clock.  

Synchronize PC Time to WinFrog Time 
Synchronizing the WinFrog time does not change the system time and if an adjustment has 
been made and WinFrog is closed then rebooted, the adjustment will have to be made again. 
Enabling this option allows WinFrog to set the system clock. 

Note: This feature does not provide precise synchronization of the PC system time to an 
external time source. It is intended only to enable a rough synchronization of the PC time to 
eliminate large time adjustments to WinFrog time upon subsequent re-launches of WinFrog. 
The variation between the WinFrog time and the system time is checked every 20 seconds 
and system time is reset to WinFrog time if the variation is greater than 5 seconds. 

Time Accuracy 
The tolerance setting controls the maximum limit of the deviation of the WinFrog clock 
from the timing device before WinFrog resets its clock. This should not be set too small, as 
the clock will constantly be reset.  
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WinFrog monitors the variation between the UTC time and the WinFrog clock using a 
fading history of the last 20 samples of the variation between the WinFrog clock 
synchronization time stamp and the associated UTC time. This is filtered using a Central 
Tendency algorithm. When the filter result exceeds the tolerance, the clock is reset. 

Corrections 
Apply Time Correction This check box and associated edit box allows 

for a minor correction to, for instance, correct 
for a constant transmission latency. 

Local Time Offset This allows the user time to be local rather than 
UTC. All logged and displayed times are in the 
local time, UTC plus offset. 

Raw Data Logging 
Logging is done to the *.RAW data files and is controlled by the selected method of raw 
data logging (see Configure Raw Data Logging). Selection here merely determines what is 
to be logged.  

Enable Logging of If selected, then both time data and 
All Data WinFrog clock adjustment information will be 

logged. Note, if the raw data is set up to log at 
events (Event Configuration dialog) then time 
data will only be logged when an event occurs. 
Changes will always be logged unless raw 
logging is off. 

Enable Logging Only If selected, a record will be logged only 
when time is adjusted when the WinFrog time is adjusted. This record 

will be logged when it occurs for any raw 
logging (Event Configuration) option except 
Off. 

I/O Time Source 
The device name dropdown box lists all the current devices capable of providing time 
synchronization. Selecting the desired device will cause the message type dropdown box to 
be populated with the timing telegrams or methods available from this device. Note if 1PPS 
is selected, WinFrog must receive the pulse for the time synchronization to work.  

Devices 
The following devices support time synchronization: 

GPS Devices 

MX 7140 $--ZDA telegram 

MX 9400 1PPS with$--ZDA telegram 

NMEA GPS* $--ZDA telegram and/or 1PPS with $--ZDA telegram 

NMEA GPS (Sercel)* $--ZDA telegram and/or 1PPS with $--ZDA telegram 

POS/MV (NMEA) $--ZDA telegram and/or 1PPS with $--ZDA telegram 
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NR103 Prop(rietary) $--ZDA telegram 

MultiFix UKOOA Proprietary UKOOA telegram 

TRIMBLE CYCLIC Proprietary telegram 

TRIMBLE TSIP Proprietary telegram 

NovAtel CON $--ZDA telegram 

TIME BASE Devices 

TRIMBLE 1PPS 1PPS and Proprietary telegram 
ODP TIME Proprietary telegram 
TRUETIME Proprietary telegram 

 
* These devices also support the synchronization of WinFrog to the NMEA $--GGA 

and $--GLL telegrams. However, these are not recommended as there is an inherent 
latency in the UTC time included in the telegram and the time the telegram is sent 
out. This is typically approximately 0.7 seconds for a $--GGA telegram. 

Interfacing 
The preferred and most precise option is the 1PPS, followed by the $GPZDA telegram, then 
the $GPGLL telegram and lastly the $GPGGA telegram. The generic option is device 
specific and is available when the device uses a proprietary telegram. 

NOTE: The 1PPS option is not available when interfacing with TCP/IP sockets.  

If using the 1PPS... 

WinFrog looks for the 1PPS pulse on the CTS line of the serial port, therefore if the 1PPS 
signal is to be used, this must be connected to the CTS line at the WinFrog serial port for 
the COM port selected for the device. A logic ground must also be present. 

Some GPS receivers produce a pulse that is too short and cannot be detected by a 
computer’s hardware. In which case, the signal must be stretched. The voltage must also 
conform to EIA RS232C standard. The Trimble 4000 is an example of this. In this case, a 
pulse stretcher is required. The stretched pulse needs to be connected to the CTS line of the 
same COM port that the GPS receiver is sending its time and navigation data to. 

On many receivers, the 1PPS can be used as is, for example the Sercel NR203. 

Besides the 1PPS signal, WinFrog requires a telegram defining the time of the pulse just 
received. Typically the NMEA $--ZDA telegram is used unless a device specific telegram is 
used, for example in the case of the Trimble 1PPS device (Trimble 4000). 

The 1PPS and associated time telegram must be input on the same port. 

If using a NMEA telegram... 

In the case of using a NMEA telegram such as the $--ZDA alone to synchronize WinFrog, 
the reception of the starting character (‘$’) of the telegram is detected and time stamped. 
This time stamp is used as the pulse detection time associated with the telegram’s UTC 
time. 
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Note: NMEA specifies that the time in NMEA telegram be UTC. The following effects 
output using the NMEA Output device; if WinFrog is not synchronized to GPS then the 
time in the telegrams will be the WinFrog time, which is based on the PC time when 
WinFrog was run. If WinFrog is synchronized then you have a choice to either place 
UTC or local time in those telegrams that contain time. Local time will be UTC with 
the Local Time Offset applied. 
 
Other devices that output messages always use the WinFrog time. 

Tracking Offsets Window 
The Tracking Offsets window displays the real-time Working Map Projection coordinates of 
all Tracking Offsets configured on a vehicle, as well as survey Line tracking Distance Down 
Line (DDL) and Distance Cross Course (DCC) information, if a survey line is being tracked. 

Only one Tracking Offsets window can be displayed in WinFrog, but the same window can be 
used to view Tracking Offsets for any WinFrog vehicle by simply toggling the Vehicle button 
located in the top of the Tracking Offsets window. 

The Tracking Offsets window can only be configured for size. Only those Tracking Offsets 
that are configured with their Plot option enabled will be seen in the Offsets window. 

Note: although the Tracking Offsets window displays the position of all Plot option enabled 
Tracking Offsets, only the coordinates displayed in the Vehicle Text window (i.e. the single 
Tracking Offsets point that is currently enabled) are recorded by WinFrog during Automatic 
or Manual Eventing. 

Vehicle Tracking Offsets are configured by selecting the main menu item Configure 
>Vehicles > Configure Offsets. For more information, see To Configure Offsets in Chapter 
6: Vehicles. 

To Display the Tracking Offsets Window 
1 From the View menu, choose Tracking Offsets. 
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In the Tracking Offsets display above, the Barge vehicle is configured with 6 Tracking 
Offsets and is also tracking a survey line. As mentioned above, to see information for other 
vehicles, select the Vehicle button in the top right corner of the window. 

Cable Model Windows 
WinFrog’s Cable Model extension module provides real-time calculation and display of cable 
lay operational status. The real-time cable lay information calculated includes Desired and 
Actual Slack values, as well as cable installation “Ahead and Behind” information. This 
information, and various other data pertinent to the installation of a cable, is displayed in both 
the Cable Model Large window and the Cable Model Small window. 

Details of the configuration and use of the Cable Model windows are found in the Cable 
Management Extension Module User’s Guide. 
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